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Introduction
Welcome
Congratulations on purchasing your new WayPointtm PDA (Personal 
Digital Assistant

 
A PDA is a small 
computer that fits in 
the palm of your 
hand.

 
PIM functions are 
programs that keep 
track of things such 
as an address book or 
your calendar.

 
A GPS is a radio that 
can receive signals al-
lowing it to compute 
your position any-
where on the planet.

). You now have the convenience and flexibility of a 
Portable Navigation tool and full-featured personal digital assistant, 
enabling you to automatically route to places of interest, addresses or 
locations in your contact list. In addition, you can use PIM (Personal 
Information Manager) functions to keep track of information wherever 
you go. Powered by Microsoft® Pocket PC 2003 Premium Edition, 
your WayPoint PDA offers a host of functions designed to make your 
life easier.

The WayPoint Navigation PDA is a full-featured GPS auto-routing 
mapping solution that offers door-to-door routing with turn-by-turn 
instructions. (To read about how your GPS works check “Advanced 
Topics” on page 98.) The WayPoint PDA uses GPS position 
information and maps to help the user decide on the best route to 
travel. The WayPoint Navigation software includes the full maps for 
one region. For example, the Pacific edition contains maps covering all 
of California and Hawaii. In addition all regions contain a set of road 
maps for the entire country. Unlike most other products the maps of 
your home region are preloaded. Extra regions may be purchased to 
supplement or replace the built in maps. For more information on Maps and Loading Maps see 
Chapter 8 “Map Loader” on page 73.

The WayPoint PDA is available in two model families which can be distinguished by color. The 
model 100 is Space Silver and the model 200 is Midnight Blue. They differ primarily in the GPS 
hardware capability as described below. The model 200 also includes a subscription to 
TrafficWatch and Weather Underground for one year. (TrafficWatch and Weather Underground 
are described in separate manuals.) 
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• The WayPointtm model 100 has an included CompactFlash® 
(CF

 
CompactFlash (CF) 
refers to the larger of 
the two slots in the 
top of your Way-
Point PDA. It can 
hold memory or de-
vices.

 
Bluetooth refers to a 
wireless system that 
permits information 
exchange between 
other nearby Blue-
tooth devices.

) based GPS receiver. It can be inserted in the CF slot of the 
WayPoint 100 whenever GPS navigation is needed. To save 
battery power, the GPS can be removed or turned off when it is 
not needed. 

• The WayPoint model 200 uses Bluetooth® technology in 
conjunction with a Bluetooth GPS. The Bluetooth CF card 
onboard will communicate with the included Bluetooth GPS 
receiver which is in a separate package. The Bluetooth CF 
module can also be used for other communication tasks such as 
connecting to the Internet via a cell phone. The Bluetooth 
module should be shut off when not needed to save battery 
power.

Variations on these basic model numbers include specific features not in 
the base model. The WayPoint models 105 and 205 include a license (activation code) to use 
maps for the entire United States instead of just one region. They are also called the National 
Edition. The maps themselves can be downloaded from our website or obtained from an 
optional CompactFlash card. These maps are also be available in CDROM format. The standard 
WayPoint 100 and 200 models can be upgraded easily by purchasing other regions as needed. 
For more information see Chapter 8 “Map Loader” on page 73.

The WayPoint PDA can be installed in a car using the provided portable vehicle mount. The user 
should choose a convenient spot on the windshield, left or right of the steering wheel to attach 
the suction cup. Be sure the unit is not blocking any of the view of the road. 

When driving, always use the vehicle mount so that you can maximize the performance settings 
without worrying about running the battery down. The power cable can be routed to the unit 
from the 12 Volt “cigarette lighter” power outlet and plugged into the base of the WayPoint 
vehicle mount. A small adapter cable connects the vehicle mount to the PDA unit.

No part of the hardware should be installed in front of either front airbag. Detailed installation is 
given in “Getting Started” on page 7 or the Quick Start Guide. For security, the PDA should not 
be left in an unattended car.

Caring For Your WayPoint PDA
Routine Care

To keep your WayPoint PDA working properly, please follow these guidelines.

• Do not attempt to disassemble or modify the product.

• Never place anything on top of the product.
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• Avoid using or storing the product in places where static electricity or electrical noise is 
likely to be present.

• Avoid using or storing the product in direct sunlight, or in places that are subject to 
extreme temperatures or sudden changes in temperature. Do not leave the unit in the 
vehicle mount where it might be exposed to the direct sunlight in a closed up car. The 
temperature under these conditions can exceed the ratings on the WayPointtm products.

• Keep the product away from liquids. Do not expose it to condensation, precipitation or 
excessive moisture.

• To clean the product, first unplug it from the wall socket. Wipe the screen and the 
exterior with a soft, damp cloth. Only use water to moisten the cloth; do not use soap or 
other cleaning products.

• Your WayPoint PDA features a replaceable lithium-ion battery and a backup battery. 
To reduce the risk of fire or burns, do not disassemble, crush, puncture, short the 
external contacts, or dispose of the batteries in fire or water. Replacement of the internal 
backup battery should be performed by a Mobile Crossing authorized service provider.

• The unit can be placed in the cradle charger at any time. The battery works best when it 
is topped off.

• The vehicle mount window suction cup will attach solidly to the windshield, but it is still 
not a good idea to leave the WayPoint unit in the vehicle mount un-attended for long 
periods of time. This is particularly true if the vehicle undergoes wide temperature 
changes.

AC Adapter Care

• Always use the AC adapter provided, or use an optional adapter supplied or approved 
by Mobile Crossing.

• Grasp the plug, not the cord, when unplugging the adapter from a wall socket.

• If the power cord becomes damaged, replace it immediately.

• Use the power  button to turn the device off. Disconnect the WayPoint PDA from 
the AC adapter before unplugging it from a wall socket.

Display Care

• Clean the screen by wiping with a soft, damp cloth. Moisten the cloth with water only; 
do not use soap or other cleaning products.
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• Do not spray liquid directly onto the screen. Prevent excess liquid from leaking into the 
device at the edge of the screen.

• Never place anything on the screen.

• Avoid scratching the screen with hard objects.

• Do not expose the product to direct sunlight for a prolonged period of time.

• A screen protector with anti-glare characteristics is recommended for use in a vehicle or 
outdoors.

Care While Traveling

• Safeguard your data by making a backup copy.

• Turn the power off and disconnect all external devices.

• Take the included AC adapter or car charger along with you.

• Pack the product in a protective case and carry it in your hand luggage.

• Avoid exposing the product to magnetic security devices.

• To avoid interference, do not use the product on an airplane without permission. This 
unit meets FCC class B requirements and is generally safe for use above 10,000 feet. The 
FCc logo on the back signifies that the unit meets these requirements.

• The CE logo on the back of the unit indicates that your WayPoint PDA also meets the 
requirements of European countries and is similar to the FCC class B requirements.

Shipping the unit

When shipping, pack the product and all external devices in the original packing boxes or in 
similar packaging with sufficient protective padding material. Nothing should be permitted to 
rattle. 

If, for some reason, you need to ship the unit to Mobile Crossing, be sure and get an RMA 
(Return Material Authorization) number first and include this number on the outside of the 
packaging.
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Using this Manual
Many of you do read manuals and this one is organized to be read from front to back. It also 
contains an index for ready reference later. There is a glossary near the back for terms you might 
not be familiar with. Many of these terms are also described in a sidebar.

However, it is recognized that some may only wish to skim the manual or are very familiar with 
some aspects and may choose to skip over those sections at first. This can be a very useful way to 
get going quickly but at some point it would be a good idea to return to those sections as they 
cover some unique features in the product.

If you want to skip around you will find the following descriptions helpful in determining your 
choices. The tabs on the cover provide and easy way to get to the various chapters.

• Chapter 2 “Getting Started” supplements the Quick Start Guide. It provides a text 
check list to complement the picture check list in the Quick Start Guide. It also provides 
a tour of the buttons and hardware features of the WayPointtm PDA. Finally it includes 
information on charging and powering the unit as well as more installation information 
to complement the Quick Start Guide.

• Chapter 3 “Basic Operations” provides information for new PDA users on how to 
get started with a Pocket PC. It also provides some information on unique features of 
this particular PDA. If you are familiar with Microsoft Pocket PC PDA’s you may be 
able to just skim this chapter. 

• Chapter 4 “Getting Started with Navigation” contains the introduction and getting 
started information for the GPS navigation features of this product. This is where you 
will learn to use the GPS itself. If you are familiar with GPS operation using other GPS 
devices you may be able to just skim this chapter. It will be a handy reference if you have 
any problems with the GPS.

• Chapter 5 “WayPoint Operation” contains the introduction to the WayPoint 
navigation software itself. It explains the basic operation of this navigation tool. It can 
be used as a reference for learning how the various commands in the tool work and how 
the screen display is laid out.

• Chapter 6 “WayPoint Navigation” explains the automatic routing and navigation 
features of the product.

• Chapter 7 “Step by Step” is for folks that like to learn by example. It provides several 
step by step examples of performing navigation tasks.

• Chapter 8 “Map Loader” describes the included map loader application. It is designed 
to help manage your maps if you own more than one region.
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• Chapter 9 “Bluetooth Operation” is for WayPointtm 200 users who will want to learn 
how to set up their Bluetooth GPS unit. It also introduces some basic Bluetooth 
features.

• Chapter 10 “Advanced Topics” is intended to go beyond the basic operation of the 
unit and to provide some more information for the curious. It also provides information 
on the optional tools that are included on the CD-ROM.

• Chapter 11 “Troubleshooting” provides help for users that are having specific 
problems with their unit. This is the first place to check if something doesn’t work right. 
If you are not sure how something is supposed to work you can use the index to find 
information about the topic.

• Appendix A “Technical Specifications” provides all of the detailed information about 
the specifications in a table form.

• Appendix B “Regulatory Notices” provides information on the FCC, EC compliance 
and some important Safety information on using the unit and carrying for the battery.

• Appendix C “Firmware Upgrades” provides information on how to upgrade the 
firmware in the unit.

• Appendix G “Glossary” provides definitions of some of the terms used in the manual.

• Appendix I “Index” is where to look when you need to learn about a particular topic.

• The Back Cover provides a quick reference to some key features of the WayPoint. 
navigation features.

We recommend that you keep the manual in your glove box so it is handy. The WayPoint 
manual is your key resource but not the only one. If you would like to search the document 
electronically or want a copy on the PDA itself you will find a PDF version of this manual on the 
CD-ROM that accompanies the WayPoint PDA. The PDF version is pre-tagged so that it will 
read well on the small screen of your WayPoint PDA. There are links in all the critical places so 
you can just tap a link to move around in the document. You will need to download a copy of 
Adobe Acrobat Reader for the Pocket PC to use this feature on the WayPoint PDA. We 
recommend that this program be installed on an optional SD card since it is quite large.

The CD-ROM also contains additional information in the form of PDF manuals on Pocket PC 
operation, Bluetooth operation, and for the built in TrafficWatch & Weather Underground 
software. The Mobile Crossing web site may contain updates to any or all of these manuals.
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Chapter

2
Getting Started
Unpacking the Boxes
Start by preparing a suitable workspace to unpack the boxes and set up your WayPointtm system. 
Select a place that is located close to an electrical outlet, making sure that the surface is stable, 
level and clean. There are two boxes. One contains the WayPoint PDA (Personal Digital 
Assistant) and is described first. A second box contains the GPS receiver, the car mount, and DC 
power cord. 

Open the WayPoint system box carefully, ensuring that you do not damage the box or any of the 
other packing materials. The box will be useful to save in case you ever have to store or ship your 
WayPoint Pocket PC PDA.

The package contains the following items:

Outer Box

WayPoint Navigator’s Handbook

Supplementary User’s Guide

Additional Software instructions

Warranty Card

Product Registration Card with Warranty sheet

Quick Start Guides - One for the unit and one for Map Loader.

Support Sheet

EULA booklet – End Users License Agreement
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WayPoint 100
Box 1

WayPointtm PDA

Travel Adapter (USB & Charging) 

Main Battery

Stylus

USB Desktop Cradle / Charging Stand

USB Cable

AC Adapter

Companion / Documentation CD

Plastic dust cover installed in the SD slot

Plastic dust cover installed in the CF slot

Powered Vehicle Mount

Windshield Suction Cup with Gooseneck

12 Volt Cigarette Lighter cable

Audio Cord

WayPoint CompactFlash GPS Receiver

Box 2

WayPoint 200
Box 1

WayPoint PDA

Travel Adapter (USB & Charging) 

Main Battery

Stylus

USB Desktop Cradle / Charging Stand

USB Cable

AC Adapter

Companion / Documentation CD
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Getting Started DVD

Plastic dust cover installed in the SD slot
Box 2

Powered Vehicle Mount

Windshield Suction Cup with Gooseneck

12 Volt Cigarette Lighter cable

Audio Cord

Bluetooth GPS charging cable / Adapter

Bluetooth GPS Receiver

Split Charger cable Bluetooth GPS / WayPoint PDA

Please contact your dealer if any of the items are damaged or missing.

Cable Identification

The following pictures should help in identifying the correct cables.

BT GPS Charging Travel Adapter USB Cable

The First Time You Use Your WayPoint PDA
1. Insert the main battery into the WayPointtm PDA.

a. Remove the back cover by pressing the button sliding the cover down

b. Insert the battery
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c. Place the cover on and press down to slide the cover in place. See figure below.

ABCD12345678

2. Before using your WayPointtm PDA for the first time, you will 
need to use AC

 
USB (Universal Serial 
Bus) refers to an con-
nector on the front 
or back of your com-
puter or peripheral 
device. It serves as a 
method for the data 
or power to get from 
the computer to the 
peripheral device.

 power to charge the battery. There are two ways 
to do this:

a. Connect your WayPoint PDA to a wall outlet using the 
travel adapter.

b. Plug the USB cradle into a wall outlet and dock the 
device in the cradle.

Please read the discussion on “Power” on page 20 for 
information on setting up the cradle or travel adapter for 
charging.

3. Allow a total of 8 hours to fully charge your main battery and backup battery. You must 
fully charge the battery before disconnecting the device from AC power. the first time.

4. To prepare your WayPoint PDA for use, follow this simple procedure the first time you 
turn the device on. 

a. First, remove the back cover and battery. 

b. Locate the master power switch beneath the main battery.

c. Unscrew the top of the stylus and use it to slide the switch from off to on. See 
the drawing on the next page.

d. Put in the main battery.

e. Wait 1 minute for the Welcome Wizard to be displayed.
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f. Follow the on-screen instructions to calibrate the screen and set up the operating 
system.

g. Do not remove the unit from the charger during these steps unless it has been 
charged the full 8 hours.

5. There is a backup battery in the unit. It will be recharged from the main battery and is 
used to permit swapping the main battery for a spare without losing any information. 
You are likely to see a message about a low backup battery when you first turn the unit 
on.

Slide the Master Power switch from off to on the first time you use your WayPointtm PDA. Note the use of 
the top of the stylus as shown in the picture. Please note that the power switch must remain switched on 

when the WayPoint PDA is in use.

Turning Your WayPoint PDA On and Off
Turning Your WayPoint PDA On

Your WayPoint PDA offers the convenience of instant on, enabling you to start work 
immediately without waiting for lengthy initiation procedures to be completed. To turn on your 
WayPoint PDA, press the power button, the recorder button or one of the 4 programmable 
application buttons.

It is possible to disable the feature of turning on the unit from the four (4) application buttons 
and the recorder button. For details see the Pocket PC reference guide included on the CDROM.

Turning Your WayPoint PDA Off

When you turn your WayPoint PDA off, the device will not shut down completely, but instead 
enters standby mode. Although power consumption is extremely low, the system clock continues 
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to run and the RAM contents are maintained (see “Maintaining the Batteries” on page 24 for 
more information). 

Furthermore, if you turn your WayPointtm PDA on again within 4 hours, operation will resume 
where you left off the last time you used the device. After 4 hours the unit starts with the Today 
screen.

To turn your WayPoint PDA off, press the power button located 
on the front of the device

Your WayPoint PDA is set to turn itself off after three minutes of 
inactivity when operating on battery power. You can change these 
settings by tapping Setting on the start menu, and then selecting 
the System tab and tapping Power. The Advanced tab is shown 
above. 

This setting can be overridden by the WayPoint navigation 
software. When a GPS is in use it is usually desirable to leave 
power on all the time, even when using batteries. See “Starting the 
GPS” on page 40 for more information.

Turning on your Bluetooth GPS

The Bluetooth GPS needs to be charged for at least an hour prior to its first use. It should be 
fully charged before removing power. A full charge will require up to 8 hours or even more if the 
unit is on. 

Plug the GPS into the AC adapter. The charging light will turn off when the unit is fully charged. 
When used in a vehicle, the unit can be plugged into the DC power cable attached to the vehicle 
mount to prevent the GPS battery from running down. The unit may be used without the cable 
for full wireless operation. The battery life of the Bluetooth GPS is about 8 hours between full 
charges.

Vehicle Installation
Safety First! 

• Do not mount or install any of the brackets, devices, or cables in front of any air bag.

• Do not mount any object where it obstructs the driver vision. 

• Do not route any cable where it interferes with the operation of the vehicle. 

Follow these steps to install the unit.

1. If you have a WayPoint 100 place the GPS receiver in the CF slot. 
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2. For a WayPointtm 200 mount the GPS receiver in the bracket on the back of the unit. 
The GPS power cable should be attached between the mount and the GPS.

3. Install the WayPoint PDA in the vehicle mount by sliding it in from the top or pressing it 
between the rubber side clamps. Be sure the unit plugs into the power/serial connector 
near the bottom of the mount.

4. Plug the audio cord into the headphone jack on the PDA and insert the other end into 
the mount.to use the external speaker for clear voice instructions while navigating. A 
volume control is located on the left side of the vehicle mount.

5. Attach the gooseneck to the back of the mount. The assembled unit will look similar to 
the next figure. (WayPoint 200 shown)

6. Find a suitable place in the car to mount the assembly. 

The unit can be mounted to the left or to the right of the driver where it can be easily seen. 
The WayPoint 100 needs to be mounted where the GPS will have a clear sky view unless an 
external antenna is used. Consideration should be given to possible passenger use.

7. Once the location is chosen, the area should be cleaned so that the suction cup will stick. 

8. Attach the suction cup to the windshield and depress the lock on the back to seal the 
connection. A tighter seal can sometimes be made with a damp suction cup. 

9. Plug the power cable into the unit on the lower right side. Route the power cable down 
to the power (cigarette lighter) outlet and the installation is complete.

Alternate Installation of the Bluetooth GPS

WayPoint 200 customers may wish to find a remote location for their Bluetooth GPS near the 
base of the windshield to ensure that the unit will have a good sky view for satellite reception. 
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Velcro is supplied that may be used to secure the GPS while providing the ability to easily 
remove the unit. 

1. To attach the Velcro, clean both mating surfaces and attach the pad side to the bottom of 
the unit by removing the tape and attaching the sticky side of the pad to the unit.

2. Ensure proper operation before making the final location choice.

a. Place the GPS in the proposed location and turn on both the GPS and PDA.

b. Setup up the GPS connection to the PDA using the instructions in “Getting 
Started with Navigation ” on page 38.

3. After ensuring the location has good reception, attach the hook side to the dashboard. 

4. Full wireless operation can be used up to 8 hours on batteries.

Tip - If your WayPoint PDA is Stolen

Be sure and remove the WayPointtm PDA when you leave the car. This unit is a tempting target 
for thieves. If your unit does get stolen, be sure to report this to the police and to Mobile 
Crossing. Mobile Crossing maintains a database of all registered units which may be useful in 
identifying your missing unit.

The Bluetooth receiver can also be a tempting target. It can be covered or placed out of sight so 
long at the reception isn’t blocked by metallic surfaces. If you are not planning on removing it 
every time you may want to experiment with finding a secure location. Otherwise you may want 
to consider removing the mount itself from the Goose neck.

Tip - Periodically check the suction cup.

Inspect the suction cup from time to time by looking at it from the outside to ensure that it is still 
fully sealed against the windshield. It can be removed for use in another vehicle when you need 
to by twisting the knurled knob to release the suction and then prying the cup from the 
windshield. Always clean both surfaces before attaching to the windshield.
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Tip - Special consideration for the WayPointtm 100 

GPS

The WayPoint 100 GPS receiver will work better if the whole unit is tilted back a little bit so it 
can get a view of the sky through the windshield. If it has trouble getting a lock you might want 
to find a better place to mount it. You can also just lay the unit on the dashboard until it gets its 
first lock. It will usually maintain the lock when you move it to the vehicle mount. If you 
continue to have problems you might want to consider an external antenna.

Product Registration
You can register your product by filling in and mailing the registration card or by visiting the 
Mobile Crossing web site at http://www.mobilecrossing.com/registration. Product registration 
ensures warranty coverage and provides you with the opportunity to receive update notices of 
any improvements that may become available for the product. The actual warranty coverage is 
specified on the Warranty Card that came the product.

http://www.mobilecrossing.com/registration
http://www.mobilecrossing.com/registration
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WayPoint PDA Overview
Take a few moments to study your new WayPointtm PDA. Learn the locations of the buttons, 
connectors and other hardware features.

Top view of the WayPoint PDA

Left Side View of the WayPoint PDA

1. Stereo Headphone Jack

2. CompactFlash Expansion Slot 

3. Secure Digital card slot

4. IR port for Infrared communications

5. Stylus – spring loaded. Press Down 
to remove.

6. Voice Recorder – press and 
hold to start recording sound 
via the microphone. Release to 
stop.

7. Thumb wheel – press to 
operate: move up / move 
down / depress to enter

8. Software Reset Button –
Unscrew the top end of the 
stylus and use it to press the 
software reset button or angle 
the stylus tip.



Front view of the WayPointtm PDA

Bottom view of the WayPoint PDA
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9. Microphone

10. LED –

Left: battery charging 
indicator (flashing red – 
battery fast charging / 
continuous green – battery 
80% full and trickle charging) 
Middle: Alarm / Turn Assist 
(red light)  Right: future use 

11. Power Button

12. Touch Screen

13. 4 Programmable Application 
Buttons – can be set to 
launch applications quickly. 
PDA Default settings (left to 
right): 
1. Calendar  
2. Contacts  
3. Tasks  
4. WayPoint navigation

14. Speaker

15. Cursor Keypad – press to 
operate: move up/move 
down/move left/move right

16. Charging / 
Communications Port – 
connects to the USB 
cradle or to a PC via the 
USB cable. Also used to 
connect to external 
power or serial devices.



Rear view of the WayPointtm PDA

WARNING: Be sure data is backed up 
before operating this switch. All data will 
be lost.

Software reset button shown for 
reference (item 8)
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17. Main battery - To remove the battery 
cover: 

Press the button on the battery cover 
and slide it downwards. The battery 
cover can then be lifted off. Please 
note that when the button on the 
battery cover is pressed, the device 
goes into sleep mode. 

To replace the battery cover the cover 
should be pushed firmly over the 
battery compartment, making sure 
that the tabs on the cover engage with 
the guides in the battery 
compartment. The cover can then be 
slid up into place. 

The cover should fit snugly into place 
with no gaps.

18. Master Power Switch - Unscrew the 
top end of the stylus and use to 
operate the switch (Only visible after 
battery is removed). This switch is 
used to perform a Hardware reset.



USB cradle Top View
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19. LED Charge Indicator. This 
lamp will be lit to indicate 
connection to AC power 
and will brighten to indicate 
that the spare battery is 
being charged.

20. The WayPoint PDA 
Charging / Communications 
Connector – connects to the 
Charging / Communications 
Port on the base of the PDA

21. Charging Bay for spare 
battery

USB Cradle Bottom View

22. 22. DC in jack

23. 23. USB Cable Port
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Power
Using Battery Power

Your WayPointtm PDA features a main battery and a backup battery. 

M A I N  B A T T E R Y

When fully charged, the main battery will provide enough power for up to 8 hours use under 
normal operating conditions, if utilized for standard PDA functions with minimum backlight 
use. However, the actual battery life is dependent on the type of use as some functions, such as 
the backlight, raise power consumption considerably.

The main battery is charged whenever AC power is connected, even if you decide to continue to 
operate the WayPoint PDA. However, connecting to AC power with the WayPoint PDA turned 
off results in a much faster charge time.

B A C K U P  B A T T E R Y

The backup battery will ensure that no data or settings are lost when the main battery is removed 
or runs out of charge.

The backup battery is charged from the main battery or from the AC supply when the unit is 
connected to the power outlet. When the main battery is removed, the backup battery maintains 
power to the memory of your WayPoint PDA so that no data or settings are lost. 

When the main battery is removed the backup battery maintains power to memory for at least 5 
minutes to permit swapping the battery. If the main battery goes flat but is not removed, data and 
settings are maintained for 72 hours.

Your WayPoint PDA will automatically go into sleep mode when the main battery is removed 
and cannot be awakened until the main battery has been replaced.

B L U E T O O T H  G P S  B A T T E R Y

The WayPoint 200 includes a Bluetooth GPS receiver that can run from its built-in rechargeable 
battery. When fully charged, it can provide more than 8 hours of continuous use. It has a 
charging indicator lamp that will remain off unless charging is need. When the charging light 
lights, discontinue use of the GPS receiver until it can be charged as reception and accuracy 
cannot be assured. 

Using AC Power

Connecting your WayPoint PDA to the AC power supply offers an alternative to using battery 
power. As well as allowing unlimited use of the WayPoint PDA while you stay connected, AC 
power also charges the battery, ensuring that the WayPoint PDA is ready for future mobile use. 
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The included AC adapter accepts 90V to 260V, enabling worldwide use with the appropriate 
local connector. 

To charge the device using the AC adapter:

1. Connect the travel adapter to the charging/communications port on the base of your 
WayPointtm PDA as shown in the picture below.

2. Connect the adapter cord to the adapter cord connector of the travel cable.

3. Plug the adapter into an AC outlet. 

The power LED shows flashing red while the battery is fast charging and continuous green 
light when the battery is in trickle charging at least 80% charged.

Direct Connection to the AC Power Supply via the travel adapter

! Important! You must fully charge the battery the first time you operate your WayPoint PDA. 
A full charge of both main battery and backup battery will take approximately 8 hours.

B L U E T O O T H  G P S  C H A R G I N G

The WayPoint 200 GPS receiver can also be charged using the same AC charger or via the 
included dual-charge cable. The dual-charge cable permits simultaneous charging of the GPS and 
the PDA. The Charging lamp will light on the GPS when it is being charged. This lamp will dim 
and finally shut off when the GPS is fully charged. 



22

The dual charge cable is shown in the figure below.

U S I N G  T H E  U S B  C R A D L E

By keeping the USB cradle connected to the AC power supply, your WayPointtm PDA can be 
charged whenever it is docked. Spare batteries may also be charged by inserting them in the 
cradle.

To connect the USB cradle to the AC power supply: 

1. Insert the power cord jack into the DC-IN jack socket on the USB cradle. 

2. Plug the adapter into an AC outlet.

USB cradle
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The cradle may also be used to charge a spare battery that is not installed in your WayPointtm 
PDA. To charge a spare battery, place the battery in the battery bay after the USB cradle has been 
connected to AC power.

Using Vehicle DC Power

The vehicle mount consists of a powered cradle that houses the external speaker and holds the 
PDA as well as a gooseneck connector attached to a windshield suction cup. External power is 
brought to the mount with the supplied power cable. In the WayPoint 100 and 200 the mount 
supplies power to the WayPoint PDA though a short cable that plugs into the power/
communication port on the bottom of the unit. 

Use DC external power when the WayPoint PDA is in your vehicle. This can be supplied from a 
power (cigarette lighter) outlet via the vehicle PDA mount. Plugging the unit into the mount and 
hooking up the connector will pick up the power connection from the mount. The vehicle 
mount will keep the unit fully charged. 

W A Y P O I N T  1 0 0  G P S  P O W E R

The GPS derives its power from the PDA itself so as long as power is applied to the PDA the 
GPS will run. If the power is unplugged the PDA will continue to power the GPS from its 
battery.

W A Y P O I N T  2 0 0  B L U E T O O T H  G P S  P O W E R

The WayPoint 200 Bluetooth GPS receiver can also be plugged into the vehicle PDA mount at 
the side of the mount to obtain external power. This allows unlimited use of the GPS receiver, 
but does require a wire between the two units. Some users may prefer fully wireless GPS 
operation with the DC power cable serving as a backup when the GPS battery is low. The power 
cable will permit GPS operation while simultaneously charging the unit.

USB Charging

The batteries in your WayPoint PDA can be charged using a USB connection to a PC, even 
though the device itself is not connected to the AC power supply. However, charging the unit in 
this way is only effective when the unit itself is powered off and will take much more time. There 
are two ways of making a USB connection to a PC: 

1. You can make a direct cable connection from the WayPoint PDA, using the supplied 
travel adapter

2. You can use the USB cradle.
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WayPoint PDA Connected to the back of a PC via the USB Cable on the left and the travel adapter on the right.

There are two types of USB hardware configurations used in PC’s. 

1. One type supplies a separate 5V power source for the USB power.

2. The second type derives the power from an internal bus. 

There is only a limited amount of power available from a USB connection and sometimes this is 
divided among all the connections. Extension USB hubs are also available in two types; one has 
its own 5 Volt power while the second gets its source of power from the USB connection on the 
PC.

The WayPointtm PDA cannot be charged effectively via a bus-powered USB hub. USB charging 
is only effective via a self-powered USB hub, or when the WayPoint PDA has exclusive use of a 
USB port. The PC itself must be powered up and the WayPoint PDA must be powered off. 

If the WayPoint PDA is powered on the charging indicator will flash and the unit will receive 
some power from the USB hub but the unit will use more power than the hub can supply so the 
unit will still need some battery power and will not be charged. You can verify whether the unit is 
receiving a charge via the AC adapter or the USB connection by looking at the back of the stand. 
There is a lamp showing power is available for battery charging and it is only lit when the AC 
adapter is used.

Maintaining the Batteries

All programs, files, data and custom settings that you save are stored in RAM. This is a volatile 
storage medium requiring electrical power to remain operational. It is therefore essential that the 
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WayPointtm PDA receives a continuous supply of power, either from its internal battery or an 
external source, as any interruption will result in the RAM contents being lost. Although the 
operating system and pre-installed programs, stored in Flash ROM, will be unaffected, you will 
have to re-enter all other information. 

S A F E G U A R D I N G  D A T A

To safeguard your data, you should periodically back up your files. This 
can be done on a pc  

ActiveSync - The  
Microsoft software 
that interfaces be-
tween the PDA and a 
host computer.

 using a Microsoft program called ActiveSync. 
ActiveSync is included on the CD-ROM that accompanies your 
WayPoint PDA. This is described in the Pocket PC reference manual 
that is also located on the CD-ROM. 

There is a backup program supplied with your PDA that can use a CF 
storage card, an SD storage card, or the Flash Disk area to back up data or personal settings in 
PIM applications. See Chapter 3, “Backup” on page 33 for more details.

C H E C K I N G  T H E  B A T T E R Y

You will receive a notification when the main battery level or the backup battery level is low 
when running on battery power. While running on batteries, you can check the remaining charge 
in either battery at any time by tapping Settings on the start menu, and then selecting the 
System tab and tapping Power. 

If your battery is being charged you will not be able to see the state of the main battery without 
temporarily disabling the charging. If the battery is fully charged this will be shown even when 
power is applied.

 The battery settings screen is shown on the left. It shows both the 
Main and Backup batteries are fully charged.

When the backup battery is fully charged it will maintain power to 
volatile memory for at least 5 minutes if the main battery is 
removed. This provides ample time to swap a spare battery in 
place. 

If the main battery runs out of charge, power to volatile memory is 
maintained for 72 hours as along as the main battery is not 
removed. 

To remove the main battery, it is necessary to move the battery 
release switch on your WayPoint PDA to the release position and 

remove the battery cover. When the battery release switch is in the release position, the unit will 
automatically go into sleep mode and cannot be awakened until the main battery has been 
replaced and the release switch is returned to the original position.
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Chapter

3
Basic Operation of the WayPoint PDA
This chapter is devoted to getting you started with the WayPointtm PDA. The WayPoint PDA 
runs Microsoft Pocket PC 2003 Premium Edition. The full instructions for the use of this 
operating system and all of the applications that are provided with Pocket PC are in the Pocket 
PC reference manual which can be found on the Documentation CD-ROM. This chapter will 
provide a brief summary of the operation of the Pocket PC operating system.

Using the Stylus
The stylus is the primary method of data manipulation and data entry for Pocket PC use. For 
safety reasons, the driver should never use a stylus in a moving car. During car navigation other 
techniques can be used to minimize the need for the stylus. For example the large on-screen 
buttons allows the user’s finger to be used. Hardware buttons have been pre-programmed to 
perform common functions. 

The stylus is often the best tool for everyday PDA use and can be essential for text entry. Use the 
stylus to operate on and select items on-screen. The bullets on the next page describe the various 
ways to use the stylus.
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• Tap the screen once to select an item.

• Drag the stylus to select text and images. In 
a list, drag to select multiple items.

• If the screen is not large enough to show 
the full data, try dragging the stylus off the 
edge of the viewing area to cause the data to 
pan.

• Tap and hold an item to display a pop-up 
menu listing available actions. (This is the 
equivalent of the right mouse button on a 
pc.) Tap your selection to perform the 
action.

The Screen Elements
The screen is usually divided into three sections. At the top is the Title bar, at the bottom is the 
Command bar, and the center of the screen contains the program data. Occasionally a program 
may remove the title bar and/or the command bar from the screen to get more display area. 

The Title Bar

The Title bar is found at the top of the screen. It displays the start button , the name of the 

active program, the speaker volume icon  and the time. The title bar also displays notification 
icons from time to time such as a low battery warning.

• Tap the speaker volume icon  to change the volume level or to mute the 
WayPointtm PDA.

• The  can be used to leave the application.

• Tap the start menu  to display the list of programs, and then select a program from 
the list.
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Using the Menus

To open or switch between running programs using the start menu, tap on the start button  
in the title bar, and then select the program you want from the list. For example tap the contacts 
menu item to bring up the contacts list. In addition to the programs that can be started from the 
menu, there are icons representing the most recently started programs across the top of the 
menu. These icons can be tapped to restart a program or may be used to switch between running 
programs.

The Command Bar

The command bar is always found at the bottom of the screen. It displays menu names and 
available buttons, as well as the input panel button. These controls allow you to perform tasks in 
programs.

• Tap a menu name to see its pop-up list, and then select an action on the list. 

• Tap a button to perform an action. Tap and hold the stylus on a button to see the name 
of a button, and then drag the stylus off the button to prevent the action from being 
performed.

Entering Text

There are several ways to enter text with your stylus into your WayPointtm PDA:

• Use the on-screen Keyboard

• Use the Block Recognizer which is similar to Palm Graffiti

• Use the Letter Recognizer which allows you to enter the letters similar to how you 
would print them yourself.

• Use the Transcriber where the stylus is used to write directly on the screen. Your 
handwriting will be recognized and converted to text.

Using the Input Panel to Enter Typed Text

The input panel can be used to enter text in any program. Tap the input panel button  on the 
command bar to display the input panel. Tap the arrow next to the button to see the list of input 
options. 
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The following input options are listed:

• Block Recognizer - To select the Block Recognizer, tap 
the input panel arrow. For help with using Block 
Recognizer, tap the help button .

• Keyboard - The keyboard can be setup to permit a full 5 
row typewriter keyboard or a keyboard with larger keys 
but requiring extra steps for some key functions.

• Letter Recognizer - Letter Recognizer allows you to use 
the stylus to write on screen, just as you would write with 
a pen on paper. After you write each letter it is converted 
to a text character.

Tap the input panel arrow and select Letter Recognizer. For help with using Letter 
Recognizer, tap the help button .

• Transcriber - Transcriber also allows you to write onscreen with the stylus. However, 
this method allows you to write blocks of information before pausing for the characters 
to be recognized. The transcriber does word recognition to aid in translating the on-
screen writing.

Tap the input panel arrow and select Transcriber. A Transcriber Intro screen will be 
shown. Tap the help button for information on using the transcriber.

The input method will be shown as an icon next to the input method arrow. This icon can be 
tapped to bring the input area up or down. Generally when input is needed, the input area will 
appear automatically using the default or previous input method.

Other Methods to Work with the Screen
Using the Cursor Button

Use the four-way Cursor Button to move up and down, and side to side, when moving between 
on-screen buttons and controls. You can use this feature to scroll through lists of files and 
documents.

Using the Thumb wheel

Use the thumb wheel to move up and down when navigating on-screen buttons and controls. 
Press to make your selection. The thumb wheel can also be used to traverse any menu and to 
select items from it once the menu has been opened. In the navigation program the thumb wheel 
performs zoom-in and zoom-out functions on the map screen.
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Using the Programmable Application Buttons

The Programmable Application Buttons provide a fast and convenient way to open your favorite 
programs. Press one of the Programmable Application Buttons to instantly open the application 
assigned to that key. By default the contact list is on the second button from the left and is 
represented by the icon above the button.

Entering a contact
You can use Contacts to keep important contact information on all your friends, colleagues and 
business associates. This information can be quickly shared with other mobile device users by 
making an infrared connection. The contacts address can be used with the WayPointtm 
navigation program as a starting point or as a destination. The first entry you are likely to enter is 
yourself. With the contact application open, tap the New entry on the command bar.

• To enter the data for the new contact, tap each field. 

• The down arrows next to the name field and address 
fields can be used to provide more structure to these 
entries if needed.

• There are three address areas. These are work, home, 
and other.

• There are several phone number fields. These include 
home, business, cell phones, fax machines, etc.

• To reach more entry areas, use the scroll bar or the 
cursor pad.

• Assign the new contact to a category by scrolling down to Categories and selecting one 
from the list.

• When you are finished, tap the OK button on the Title bar.

• You can find contacts or groups of contacts by tapping Find on the start menu, and 
selecting Contacts.

• To display a contact summary screen, tap a contact in the contacts list.
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• To change the information with a contact summary 
screen displayed, tap Edit on the command bar.

• To leave the application, tap  on title bar from the 
summary screen or just start another application.

Advanced features

There are some interesting features available for Contacts from 
the tools menu. 

• You can make a copy of a contact as a starting point for 
further editing. 

• You can beam the contact information to another person. 

• The WayPointtm 200 has an additional feature. You can send the contact via Bluetooth. 
The Bluetooth option is only available from the summary list so tap and hold the entry 
to see the selection or use the Tools menu item. It is called: send by Bluesoleil.

Setting the Clock
A new PDA will need to have the clock set to the correct time and time zone. The time may need 
to be adjusted occasionally and the time zone will need to be changed if you travel outside your 
area. Use the following steps to set the clock:

1. Tap the Start menu and select Settings.

2. Select the System tab, and then tap on the Clock icon. 

3. Tap the Time tab if necessary.

4. Set the time zone and adjust the time and date. 

5. You can set up two locations, home and visiting, enabling you to work on local time 
when you make a trip without losing your home settings. Tap the Home or Visiting 
button to change the setting you want to use.
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The clock will be maintained at the correct time from your PC when you activesync the unit or 
by your GPS when you have a fix.

Alarms

The clock also supports alarms. Clicking the Alarms tab brings up the display showing four alarm 
settings. As shown the top setting has an alarm set for weekdays at 6 AM. The checked box 
indicates that this is an active alarm. The days have been tapped to highlight the full week and the 
time is set. The time itself or the bell icon can be tapped to bring up the two screens below. 

         

The clock itself can be changed by tapping the number and either tapping the arrows to modify it 
or using the input field to enter the exact value. Tap OK to return to the alarm screen.

The bell icon tap reveals the various alarm choices. The sound itself can be changed or turned 
off. Selecting an alarm entry causes it to sound momentarily. A visual alarm can be initiated with 
a displayed message and/or flashing the center light above the screen on the WayPointtm PDA.
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An alarm can also be set in the calendar application when a reminder for a special appointment is 
needed.

Owner Information
Use the start menu and system setting to reach the Owner Information icon. Tap on the Owner 
Information icon to enter your personal details. You can display a summary of the information 
when you turn your WayPointtm PDA by selecting the box at the bottom of the screen. Tap on 
the Notes tab to enter additional information.

       

The Owner Information Screen should match the Registration information that was returned to 
Mobile Crossing. The name and E-mail address will be checked by the Traffic Watch program, if 
used. Being a subscriber of Traffic Watch will provide some security if the WayPoint PDA is ever 
stolen, since its location can be determined if the program is run by the thief. Please report thefts 
or transfers of ownership of your registered product. Also report a change of E-mail address to 
Mobile Crossing or update you online registration.

Backup
It is important to always have a backup of critical information in your PDA. There are two ways 
to back up the data on the unit. They are:

1. ActiveSync on the PC. (See the Pocket PC reference manual on the CD-ROM for more 
information on this solution.). See also Appendix C - “Backup” on page 123

2. Gismo Backup on the WayPoint unit itself

Both have there place but for users that are away from home, or do not use a pc, an on board 
backup tool is critical. The WayPoint PDA uses volatile memory, meaning that if the battery runs 
down the memory is erased. Therefore it is doubly important to keep backups of the data 
contained in RAM (volatile) memory just in case. You may also want backups just in case you 
accidently erase something or make a change that you later decide needs to be un-done. 
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Note: If Gismo is not installed use the File Explorer and tap the Gismo cab file in \Windows to 
install it. The cab file is called GisMo_PPC.ARM.

To back up the full data perform the following steps.

1. Start the backup program

2. The screen displayed at the left appears with all things 
selected.

3. Tap  to initiate the backup.

4. A confirming screen will appear. Tap Start to begin. 
The screen will display the progress.

You have just backed up all your data. All processes on your 
machine were also stopped and you took a lot longer to back up 
data you probably didn’t care about. Making the backup more 
efficient is covered in the Backup Advanced topics below.

Once the backup is completed you can restore it at any time. Of course anything you restore 
won’t have any of the changes you made since the backup.

Restore

To restore the data that you backed up you start Gismo again.

1. tap the  entry.

2. A screen with no data on it will appear. The lamp icon on the Restore button will show 
you are in restore mode by turning yellow.

3. Tap the  button to bring up a list of choices from your 
previous backups.

4. Tap the one you want. The screen at the right will appear. 
The essential data is now filled in.

5. To restore everything tap . 

6. Confirm the selection by tapping Start to begin the restore 
operation.

Choices

Generally you won’t want to back up everything in RAM every 
time and you will usually only want to restore part of what you backed up unless the backup is 
caused by a complete battery loss. The screen below is similar to the first screen shown above 
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except that the Personal Data entries and Option entries have been expanded by tapping the plus 
sign to show the contents. This listing is similar for either a backup or a restore.

The list includes everything that is stored in RAM on the 
WayPointtm Pocket PC PDA and by default all items are checked 
to be backed up as shown on the screen by the checkmarks. 

For a restore the list shows everything that is in the backup file 
that was selected.

Smaller backups of less data can be useful to keep track of 
personal data that changes frequently or files that you are planning 
to edit but would like to be able to restore if the change doesn’t 
work. Your personal data can be the most important item on the 
list and you may want to consider special backups of this data.

C U S T O M  B A C K U P

To backup just the data you want:

1. Uncheck the items you do not wish to back up. Use the + entry to show more detail 
about your choices. Check or uncheck the boxes until the exact choices are made.

2. If you wish to change the filename or location, tap the  icon. Generally you will want 
to select somewhere other than RAM for your backup file. The filename should be 
descriptive. See more below under Advanced Features.

3. Tap  to initiate the backup.

4. A confirming screen will appear. Tap Start to begin. The screen will display the progress.

Advanced Features

In the System Data category is a check mark for the file system. Much of the file system files are 
actually in ROM but this setting will get all of the rest of them. The Registry is a special place used 
by the Pocket PC OS to store settings for programs. In particular this is a good thing to backup if 
you install beta software or other software that you don’t trust so that if you have to remove it 
you can restore the Registry as well. The standard remove program often leaves entries in the 
Registry.

The backup file selection  Button permits defining the file name and file location. It brings up 
a form with 4 entries to fill in. These are:

1. Name: This is the name of the file. It should be descriptive of the contents and date.

2. Folder: This is the file folder that you wish the backup to be stored in. Tapping this will 
bring up a selection list.
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3. Type: Gismo can store files in two formats. A .gbk file is the standard form, but you can 
also select a self extracting .exe file. This kind of file will automatically bring up the 
program to extract the contents if it is executed.

4. Location: This is the name of the media which defines the place that you wish to store or 
retrieve the backup. In file explorer this is the same as the top level directory name for 
extended storage locations. Tapping this will bring up a selection list. You must have the 
memory card installed to see it on this list.

The backup program works by building a compressed file in the 
Location and directory you specify. The file contains only the 
items that you selected. It can build a regular backup file or a little 
larger self-restore file. Self-The backup command can save your 
backup to any location that you may wish. It is a good idea to 
reserve an SD card especially for this purpose. While the program 
supports backups even to RAM (main memory), this should only 
be used for temporary saves.

Note that you cannot backup SD or CF card contents with this 
program. The files on these cards will not get lost if the battery 
runs down, but the recommendation is to keep critical data 
backed up by temporarily placing a copy in RAM and using the 
backup utility. It is also possible to use file explorer to copy your 

SD card to a CF card to be used as backup. Similarly, the WayPointtm navigation maps and 
programs are supplied on a Flash Disk. This is a non-volatile 128 MByte storage area in your unit. 
It is also a good idea to back this up by making a copy using file explorer to an SD or CF card. 

The figure on the previous page shows the Options menu. 

• The Backup Options include the ability to stop all running processes. This is 
important for a full backup since running processes cannot be safely backed up under 
some conditions. There is also an option to exclude certain files from the backup (such 
as previous backup files or temp files).

• The Restore Options include the ability to stop processes and the ability to handle the 
start menu based on what is restored.

• The Battery Monitor feature can automatically back up data based on a battery level 
threshold. Thus if the battery starts to get low the unit can stop what its doing and save 
the state of your RAM contents. It can also be used to simply warn you about the 
battery status and can be set to whatever percentage you might like.

About Backups

It is easy to build backups that can eventually fill up your storage so it is a good idea to purge 
them occasionally. The file explorer command can be used to erase files. You should load your 



37

backup to ensure that it is readable by the backup program prior to deleting earlier ones. It is not 
necessary to actually execute the restore to verify that the file can be read.

Using Help
This was only an introduction to the many programs and features available within the 
WayPointtm Pocket PC PDA. And, of course, you can customize it by adding more programs of 
your own choosing. The unit has an extensive help system built-in that can be used to explore the 
loaded programs and to review their operation when a manual is not present. 

• From the TODAY screen you can tap Start and then select Help to view the full list of 
available help files. 

• From within most applications you can get context sensitive help by tapping Start and 
selecting Help with the application running.

Once inside of help you can use the View command to reach the full installed help database or 
jump to the table of contents. There is a Find command to search the help file you are using. 
However, most of the time ‘help’ is designed with a table of contents and logical links so that a 
search is not necessary. The arrows on the command bar can be used to return back to the 
previous entry in the help tree.

The “WayPoint Pocket PC Reference Manual” and this manual are included as a tagged PDF 
files on the CD-ROM. Supplying pre-tagged PDF files permits users without ActiveSync to read 
the file in reflow mode on their PDA using an acrobat reader that supports reflow such as the 
one from Adobe. These files can be downloaded to the PDA for more extensive help.

ActiveSync
The installation quick start guide includes the optional installation of ActiveSync for PC users. 
The use of ActiveSync is covered in the WayPoint Pocket PC Reference manual but a few tips 
on its installation are covered here. ActiveSync is optional and is not needed by your WayPoint 
PDA.

Users wishing to sync their WayPoint PDA with information on a PC will need to install 
ActiveSync from the included CD-ROM. They will need a copy of Outlook to perform syncs of 
their contact list and other PIM data. A copy of Outlook is also on the CD-ROM. 

Users that already have Outlook 2002 or later or ActiveSync 3.7 or later already installed will not 
need to reinstall these products, however the WayPoint PDA will probably not be recognized by 
the previously installed copy of ActiveSync since it is a new product. 

If your PDA is not recognized by ActiveSync when you plug it in then place the WayPoint CD-
ROM in your CD drive and have it search the CD-ROM for the correct driver. Using the driver 
from the CD will permit your existing ActiveSync installation to work with the new WayPoint 
unit.



38

G
et

tin
g 

S
ta

rte
d 

w
/ N

av
ig

at
io

n

Chapter

4
Getting Started with Navigation 
WayPointtm navigation requires a combination of resources which consists of the mapping 
application, a set of maps, and a GPS receiver. The first step is to set up the GPS receiver 
correctly.

WayPoint 100 users should plug in the CF GPS receiver. The lamp on the receiver will light, 
indicating that the unit is on, when the GPS is selected in the WayPoint software. The CF GPS 
receiver is on Com 3. The baud rate must be set to 4800. The lamp will blink when a GPS fix has 
been obtained. If the GPS is shut off via the WayPoint software or another GPS program the 
lamp will turn off.

WayPoint 200 users should find a place for the Bluetooth GPS within approximately 10 to 15 
feet or so (no more than 30) of the PDA and with a clear view of the sky through the car 
windows. The following conditions will be noted:

• Turn the GPS unit on with the power switch and let it acquire a GPS signal. 

• The blue light should flash indicating a Bluetooth network can be established between 
the unit and the PDA. The blue light flashes quicker after a link is established. A 
connection to the GPS can be established from the Bluetooth start menu. See 
“Bluetooth Operation” on page 91 for more information on setting up the Bluetooth 
network.

• The center lamp shows the GPS status. It will light when powered on and will flash 
when a GPS fix has been achieved. 

• The third light shows the power status. It will flash when a battery recharge is needed. It 
will light steady when external power is applied and the unit is charging. 

If you are hiking with this unit, the GPS should be placed as high on your body as possible, or 
hold the unit away from your body. The water in the human body effectively blocks the satellite 
signals in the direction of your body. If you place it in your pocket the GPS antenna must be 
facing out.
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The WayPointtm PDA should be installed in the vehicle mount for car use. WayPoint 200 users 
should start the Bluetooth radio and ensure a connection to the GPS receiver. This can be 
accomplished easily by selecting the “Start GPS” entry from the Bluetooth menu. Then follow 
the on screen instructions to establish the default connection. See the chapter on “Bluetooth 
Operation” on page 91 for more details.

Road Safety
Before launching the WayPoint navigation software, road safety should be considered. A GPS 
navigation device is an important tool when used properly but it can be a distraction to the driver 
if used improperly. 

• A stylus should never be used by the driver while a vehicle is in motion. 

• The route should be set up ahead of time before the car ever moves from its parking 
place. It is possible to set up the route in your home with the GPS off if desired.

• Make sure the WayPoint GPS has your current location before starting. 

• The driver should depend on voice prompts whenever possible and only occasionally 
glance at the screen. 

• Automatic recalculations should help prevent any need to interact with the screen.

• If you have to deal with the program use your finger for a stylus.

• Use the buttons and the thumb wheel to the maximum extent possible. Depressing the 
Thumb wheel on the map screen selects the tools menu and the thumb wheel can be 
used to move up and down the menu itself and depressing the switch selects the item.

• The thumb wheel provides zoom in and zoom out capability.

• Pull off the road if you need to do anything complicated.

Mobile Crossing is not responsible for your actions. Use care when operating this unit. 
Note that, in the discussions that follow the term locations, landmarks, and POI (Points Of 
Interest) will be used interchangeably. They all indicate some object or location that you are 
interested in.

Starting WayPoint Navigation Software

 The Mobile Crossing WayPoint navigation software can be started by pressing the right 
hand button on the face of the PDA just below the screen. It can also be started like any other 
program by tapping the icon on the start menu, if you prefer. You should install a map memory 
card if needed for your trip before starting the program. The program will open with a splash 
screen and then load the map display. While working inside the WayPoint navigation software, all 
four of the hardware buttons below the screen are defined to do useful tasks. From left to right 
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these are called Favorites, Detour, Status, and WayPointtm buttons. From the map screen the 
buttons work as follows:

Press the Button Press and hold the Button

 
Favorites

Navigate to one of your 
favorite locations. (See 
“Route to Favorites” on 
page 58.)

Save an entry in locations at your 
current position. (See “Saving your 
home location” on page 44.)

 

Detour

If no route then bring up 
the route form else 
Route with Detour. (See 
“Building a route” on 
page 56 or “Detours ” on 
page 62.)

Navigate to nearby Gas Station, 
Restaurant, or other Location. (See 
“Take A Quick Detour” on 
page 58.)

 

Status

Check GPS status by 
displaying the GPS 
screen. (See “Starting the 
GPS” on page 40.)

Provide voice prompt with 
distance to and direction of next 
turn. Use this to repeat a message 
that you missed.

 

WayPoint

Go to previous 
application (Leave 
WayPoint navigation).

Start TrafficWatch & Weather 
Underground programs. Other 
quick start programs can also be 
configured.

The WayPoint  button is the method of starting WayPoint navigation software and leaving 
WayPoint navigation software. The effect of the button is to toggle between navigation and 
another task. 

Subscreen Button use

When viewing a subscreen such as the GPS information, pressing the same button again (or any 
of the left three buttons) will be the same as OK. Pressing the WayPoint  button (which has 
no subscreen) performs a cancel.

Starting the GPS
After starting the software a connection should be established between the WayPoint program 
and the GPS installed above. 

Press the GPS status button  to reach the screen where the GPS data is displayed. One of 
the two GPS views shown below will be visible. The left and right cursor keys can be used to 
switch screens.
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The GPS Data Screen

The GPS Data screen is shown above on the left. This data screen shows the GPS running and a 
destination selected. However, this is not likely to be the case the first time you run the program. 
The Satellite Map screen is shown above on the right. When you enter the GPS command either 
of these screens may be shown. 

• Other things on the GPS Data screen include the current latitude & longitude, the 
altitude, the current speed, and heading. If a destination is selected then its name and the 
range will be shown. The center shows a compass like display with an arrow showing 
the direction of travel. In addition, if a destination is selected a red line will appear to 
show the direction to the destination. 

• This screen is where the GPS is started or stopped. It can be restarted each time the 
program is started or you can set it up to automatically start in the WayPointtm software 
general program settings.

• The GPS status is shown here. This will indicate if a GPS is connected, if it is currently 
acquiring satellites, and if it has a fix. A 2D fix means that the altitude is not being 
computed while a 3D fix shows indicates more satellites are being used as part of the 
solution and the overall solution is likely to be more accurate.

Satellite Status

The Satellite Map screen can be chosen from the view menu or by the left/right cursor keys. It is 
shown above on the right. It has the same start/stop boxes as the data screen but the rest of the 
screen shows the satellite display. 

• This is a nice screen to view if you are having trouble getting a GPS fix. You can use it to 
check for satellite reception. The display shows the various satellites in their 
approximate location in the sky with the top of the screen pointing north. The screen 
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can display satellite signal to noise ratio (strength) or the satellite ID's. Most of the time 
the strength is what you want to view.

In the figure, there are 8 satellites in view and 5 are being tracked. This does not mean 
that 5 are being used as part of the solution however. A tracked satellite may or may not 
be part of the solution. 

For example, the ephemeris data may not be downloaded yet or the satellite signal 
strength may not be high enough to use although it is being tracked. Generally, a value 
of at least 28 is needed for reliable reception on the WayPointtm GPS receivers supplied 
with the product. One of the satellites shown in the figure has a value below 28.

A minimum of 4 satellites is required to produce a 3D fix. More will often produce a 
slightly more accurate position.

• The first time you use your GPS you should find a place with a clear view of the sky, 
start the GPS and give it some time to find your current location. This initialization will 
allow it to get a GPS fix much faster the next time. It is better if you are not in the car 
for this step since the car itself may block some of the signals. See “Using the Cursor 
Keys” on page 43

GPS Settings

The settings menu item shown at the bottom of the screen should 
be tapped to show the COM port you need to select and the baud 
rate which must be set to 4800. Once the correct settings are made 
you can return to the status page to start the GPS. 

• A WayPoint 100 should be set to COM 3

• A WayPoint 200 should be set to COM 8 (Perhaps 7 or 9 
depending on the configuration, let the Bluetooth software pick 
the port.).

The settings menu choice is the place to choose the particular GPS 
settings and GPS options. Options include the ability disable 
power off and to automatically handle the screen so that you don’t 

have to operate the controls while traveling down the road. Using the automatic settings are 
recommended. 
 

• Auto-scroll will keep the GPS display on the map screen with the map itself moving 
underneath the GPS position. 
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• Auto-rotate will keep the map always point such that the current movement is toward 
the top of the screen. This will make the turns a head match the idea of left/right instead 
of dealing with compass headings. 

• Auto-zoom will change the zoom setting as you get closer to a turn so that the turn will 
be shown with more detail.

• Lock To Road will cause the GPS position to be shown directly on the road even if 
there are errors in the map. 

• The Center View Forward check mark relocates the GPS position so that there is 
more screen area devoted to the map ahead of you than behind you. 

• The WAAS check mark enables WAAS reception for increased 
accuracy in areas where

 
WAAS stands for 
Wide Area Augmen-
tation System. This is 
a system maintained 
by the FAA to pro-
vide more accuracy 
and integrity for GPS 
signals used by air-
craft. 

Your WayPointtm 
unit can make use of 
this system for more 
accuracy on the 
ground as well. It is 
generally not needed 
for vehicle naviga-
tion.

 the WAAS satellites can be received.

• There is support for a GPS log that will keep track of your 
travels by saving GPS position data in a file periodically. It will 
wrap around if the file size is exceeded. It is a good idea to clear 
the log prior to starting a trip. The file can be reviewed later. 
Check “Using the Log file” on page 103 for more information.

• Press the GPS status  button a couple of times to return 
to the map page.

Using the Cursor Keys

The cursor keys can be used while looking at the GPS status screens. 
The left and right keys will rotate through the satellite status screen, the 
GPS data screen, the trip summary screen, and the GPS setup screen. 
Note that the trip summary screen is only useful if trip logging is turned 
on in the GPS setup screen. It provides data about the trip such as 
average speed, distance, number of stops, and maximum speed. A new 
trip is generated automatically if the stop time exceeds about 10 minutes.

Starting the GPS for the first time

The very first time you use the GPS or if you move the GPS more than 200 miles from the last 
location where it was used the unit will have to search the sky to find its location. This process 
can take up to 10 minutes to locate your position, or even longer if the unit does not have a clear 
sky view. The unit should remain stationary until it has a fix. 

If you leave the GPS running in places where it cannot get a fix it may revert to the search the sky 
view even though it has not been moved. This is caused by the unit assuming it was moved a 
long distance since it couldn’t get a fix where it is. For this reason the GPS should not be turned 
on and left to run in the house. It will recover from this condition the next time it is out of doors 
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but expect it to take another 10 minutes or so. This condition can also occur if the unit loses track 
of time caused by leaving it off for a long period.

The following screen shots shows the “search the sky” sequence.

    

The first picture shows that the GPS is sending information to the PDA but no satellites have 
been found. The second picture shows that it has found some satellites but has no idea where 
they are in the sky. Once the unit is able to compute a fix it will place the satellite locations in the 
correct place on the screen display. You can begin to navigate at this point but it would be better 
to wait for one more satellite to have a 3D fix.

Saving your home location
Once you have a satellite fix the GPS location will be displayed on the map as a small doughnut 
shape. The first things most users want to do is to save their home location. Having your home 
location stored away makes a lot of sense since it will likely be the starting point or destination for 
many of your trips.

• If you are still parked in your driveway or standing in your yard 
you can save the location by pressing and holding the favorites 

button . 

By the way, why is it that people park in a driveway and drive on a 
parkway? Anyway, as soon as you release the button a screen will 
appear that can be used to record the location you just set. 

• The only data you need to supply is the name which in this 
case is likely to be ‘Home’. A default name that shows the date is 
automatically provided but you are likely to want to change it. In 
the figure on the left the date was cut and pasted into the 
additional information field and a new name entered.
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• Other things can be entered such as a category and picking an icon but these things can 
be done later if you prefer. 

• You can name your own categories, so a category like ‘family’ or ‘residence’ would be 
good choices. You can also just leave it blank or pick an existing category. 

• If the data entry field (keyboard) is removed as shown above you will find some more of 
the form. 

• You can select the zoom level used by the icon. 

• Tap OK to save the point. You have just created your first Landmark.

You can create as many landmarks as you wish to mark GPS locations. They can also be 
created from the map without needing the GPS position. (See “Landmarks ” on 
page 53.)

• Tap the location you just created (which may be under the 
doughnut) and a box will appear describing the object. 

• Tap and hold on the box anywhere and a menu will appear. 

• Select Add to Favorites. 

Surely your home location will be one of your favorites! 

You might notice that you can edit, move, or delete this point with 
this menu or set the Landmark as the starting point for the next big 
adventure. You can tap any object on the screen with similar 
results.

• Press the left button again (but don’t hold it this time) and a menu will appear of your 
favorite landmarks will appear. 

Notice that home is in this very short list. Actually the list can grow to eight entries. After eight, 
the bottom entry will be dropped off if you add any more. Use the organize function from the 
menu to keep your best favorites near the top of the list. The list can be used to select the target 

destination for navigation, if it is displayed, by pushing the favorites  button.

Add Locations to Favorites

There is an option to favorites that hasn’t been mentioned so far. On the Tools > Settings > 
program options is a setting to automatically add Locations to Favorites. It changes the entire 
idea of favorites to be recent instead. The 8 most recent locations will be maintained in the favorites 
list, which can be handy if you don’t care much about keeping favorite locations. It is also a good 
way to collect locations initially without having to make them manually. 



46

G
et

tin
g 

S
ta

rte
d 

w
/ N

av
ig

at
io

n

If you want both you might consider making a favorites category in your locations database. 
Remember that only the last 8 locations are saved in the recent list so you will want to make a 
copy of them in the Locations database if you want to keep them permanently.

1. Tap on the sign post icon to bring up the list of favorites.

2. Tap the one you want to save in your locations file. The screen will display this location in 
the center.

3. Tap the location to bring up the text display.

4. Tap and hold on the display to bring up a menu that includes Add Landmark to add this 
location to your landmark file. You will not be given this option if the location you chose 
was already in your landmarks file.

Where to from here
At this point in the discussion users are likely to want to go in several different directions. 

• Some will want to jump in the car and drive around after getting familiar with the map 
screen and how to use it. For them the next chapter to read is Chapter 5 “WayPoint 
Operation” on page 47 (the next page).

• Others may be much more interested in creating some routes and finding out how the 
route engine and navigation works. They should jump to Chapter 6 “WayPoint 
Navigation” on page 54 and read about their new favorite topic. 

• If you would rather just see examples with step by step instructions with minimal text 
then try Chapter 7 “Step-by-Step” on page 65. 

Of course, you will want to read all of the chapters eventually.
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Chapter

5
WayPoint Operation
Once the WayPointtm Navigation program has been started and the GPS connection has been 
establish you are ready to view the maps and operate the program. You can view the help file if 
you need to review the operation of any command. When the map screen has a local map loaded 
and you are zoomed in quite a way, it will look something like this:

The Map Screen

 The screen display to the left shows your current location, if a 
GPS is in use, as a circle with an arrowhead on it indicating the 
direction of travel. The color can be customized by the user.

The banner has been removed to show more map area. This is a 
configurable option. If you remove this title area you will need to 
leave the WayPoint software using the WayPoint button or bring 
up a subscreen to use the system menus.

Other items that can be seen are an optional scale (lower left 
corner), and points of interest (POI's), such as hotels and 
restaurants, which are also called landmarks. Note that some of the 

POI's do not have icons so they are shown as small circles on the map. As you zoom out all of 
the POI's will be shown as small circles. 

An arrow near the right bottom corner of the screen shows the direction of North. 

The map can be panned in any direction just by touching the screen and dragging it in the 
direction you want to go, or you can use the cursor keypad to do the panning. 
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As you travel the GPS position will remain almost stationary and the map will travel under it. The 
location of the GPS icon is an option. As shown it keeps most of the screen ahead of you. You 
can set it to be in the center of the screen if you wish. The two black dots just visible behind the 
GPS icon are the end of an optional track log. 

Another option is to have the screen oriented with the direction of travel toward the top as 
shown here. That way all of the turn directions can be left and right. You could elect to always 
have north or the direction you choose at the top. This can be useful if you are trying to match 
the map display with a paper map.

WayPoint Software Command Bar

Across the bottom are the Tools menu selection 
and several icons. 

• The two at the left are for zooming in (one 
fixed amount and one variable)

• The next two are for zooming out (fixed 
amount and twice the fixed amount). 

• It is better to use the thumb wheel when traveling in a car to do the zooming. 

• A map rotation button is next. Tapping it brings up a compass rose which can be used 
to rotate the map just by tapping the location you want to be at the top. 

• The next two icons are the plus and minus and are used to control the amount of detail 
present in the map. They can be tapped at any time to reduce clutter (-) or show more 
detail (+). 

• A signpost is next for finding locations and quick selection of your favorite places. 

• The last icon permits full screen maps or maps with a pane at the bottom with 
additional data on it. 

The Navigation Pane

The Navigation pane in the WayPointtm software can be turned on or off with the nav pane 
icon. It contains important data for the user.
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The navigation pane is where all the navigation messages are 
shown or, when not navigating, it will show the street name you 
are traveling on along with the direction you are traveling and 
upcoming cross-street names or exits. 

Tapping on this pane will return the map to the GPS position if 
you happen to scroll it away. The screen on the left shows a map 
with the information pane enabled. The name of the street you are 
traveling on is shown along with the name of the next street ahead 
and its distance ahead is shown. 

A small drawing shows the direction of the street if it is a T 
or will show it as a cross street. Even the angle of the street is shown. These values are updated as 
you travel down the road. This small drawing will show the relative direction even if the main 
map is set to north up.

The Tools Menu

All of the menu selections are on the Tools menu and are listed 
below. The Tools menu could be tapped, however, the best way 
to reach the Tools menu is to press the thumb wheel. The thumb 
wheel can then be used to select the entries as well. The 
commands on this menu include: 

Exit – A command that stops the program. (The  in the top 
bar on some screens leaves the program running). In particular the 
Exit command stops the GPS connection.

Help – A command to bring up the online help screen. This is an 
online reference manual for the program. All of the commands 
and options are covered. 

Settings – This menu brings up the customization settings (covered below)

Landmarks – A menu that provides the ability to define your own Landmarks (POI's) or view 
the ones you have already defined. (covered below) 

Distance– The distance calculator will show the distance between two locations on the map. 
You can even trace the route on the road and it will show the distance covered.

Find – This is the main find menu, a subset of which is repeated on the sign post icon. (covered 
in the Navigation chapter “The Find Approach” on page 60)

Navigation – This is the main menu to set up and manage routes. (covered in the Navigation 
chapter “WayPoint Navigation” on page 54)



50

W
ay

P
oi

nt
 O

pe
ra

tio
n

GPS – The GPS command: provides GPS status and control. (covered in the “Getting Started 
with Navigation ” on page 38.)

Choose Map – A command that is used to manage maps. (covered in “Using “Choose Map” in 
the WayPoint software” on page 86.)

Display and Control Options

As discussed in the GPS section, the GPS position icon can be set to lock to the road position. 
However, if it you don’t select that option most of the features acts as if it was on anyway. 
Tapping on the map: 

• Always snaps to the nearest road or object.

• Draws a little house to show the snapped location on a road. 

• Displays the address in a box. 

• Optionally it can display the name of the city, the latitude/ longitude location, and speed 
zone for roads. 

Tapping the box removes it or it will disappear automatically if you scroll or do anything else with 
the screen. You can tap and hold on the box to bring up a menu that can be used to work with 
that object such as setting it as a destination or add it to your favorites. 

Tapping a POI object shows information about the object that includes the data about its 
location, its name, and perhaps a phone number. If it is one of the Landmarks you defined, it will 
display your comment data. There is a limit to the number of lines displayed so if you don’t see a 
phone number you can turn off one of the optional display items to reveal it.

You can also touch and drag the screen to pan it in any direction.

Using Hardware Buttons

Most of the important commands have already been programmed to a hardware button. 

• The cursor pad can be used to pan the map (when not navigating). 

• The thumb wheel can be used to zoom in and out. Pressing down on the Thumb wheel 
will select the tools menu and the thumb wheel can be used to select entries from the 
menu. 

• The 4 hardware buttons under the screen are all pre-programmed to do useful things.

It is important to take advantage of these features, as it can be dangerous to use a stylus while 
driving down the road.
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Customizations
Customizations are reached from the Settings command. Once you select any customization 
you can move between settings using the cursor left and right keys. Customizations include:

• Map Features

• Program Options

• GPS Options - see “GPS Settings” on page 42

• Routing Options - see “Routing Options” on page 61

• Navigation Options - see “Customizations” on page 64

• Proximity Alerts - see “Proximity Alerts” on page 52

• Map Colors - see “Color Customizations” on page 51

• Sounds - see “Sound Settings” on page 64

Map Features

Map Features covers the display of information on the map screen. You can choose to show a 
Scale Bar, Street names, city/town names, city boundaries, landmarks, and a GPS trail (track log 
must be on). In addition you can choose additional data to be displayed when tapping an object. 
This data includes coordinates, city name, and speed data for roads. 

Program Options

Program options include the ability to:

• Show Splash Menu at Start

• Activate GPS at Program Start

• Auto Add Locations to Favorites

• Use Metric Units

• Hide Pocket PC Title Bar

• Set the language if you have the optional language files.

• Control the backlight behavior while navigating.

Color Customizations

Customizations include the ability to show certain optional data on the screen, change the 
displayed units, and the screen colors. There are two sets of screen colors, one for day and one 
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for night. The marketing department thinks you might not realize why there are two choices. It is 
dark at night and the day colors could be too bright. The day screen is on the left.

       

Each of these settings is fully customizable to contain just the color scheme you prefer. The GPS 
icon is set to red if a GPS signal is lost. Making this red all of the time would mask this feature 
unless you changed the definition of red! 

The color option can be set to automatically switch between the day screen and the night screen 
at dawn and nightfall.

Proximity Alerts

Proximity Alerts can be set to provide a signal when you get close to 
an object. You choose the category that you are interested in and 
when you want the alert to be triggered. You can also choose the type 
of alert, audible or visual. When you get close to the object the trigger 
will be set. The figure on the right show the visual on screen 
indication of getting close to a school. One use would be to know 
when a school is nearby so that you can be especially alert for children. You can also set up a 
category that you are looking for and then initiate a route to that location after the alert is 
triggered. Only one category can be specified by you can use user defined locations and set up a 
special category for objects you are interested in. You can wait for the alert to time out or you can 
tap the close button to dismiss it.
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Landmarks 
Landmarks1 is the name for a personal database that contains 
Landmarks created by the user. 

• These can be used for personal places like the homes of your 
family. 

• They can also be used to supply the locations and names of 
businesses that are missing from the map database. 

As mentioned in the last chapter, this is where the information is 
stored when you press and hold the left button. However, these 
locations can also be entered directly from the map using the 
command Tools > Landmarks > Add Location. 

If you select an address on the map by tapping on it and then create a landmark, that address will 
be shown in the comments.

The command Tools > Landmarks > Show Locations will display the screen shown at the 
left. Any of the entries can be edited or deleted from this screen. Tap Go To to view the location 
on the map. 

Categories can be the same as the ones in the POI database supplied with the WayPointtm 
software or they can be new ones that you make up. If they are the same as POI categories then 
the entries will be mixed in with other items of that category when you are searching.

You can send the database to your friends or upload it to the Mobile Crossing forum with a 
descriptive name and others can use it for viewing with their maps. However only the one default 
file can be used for adding information to the database.
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 Chapter

6
WayPoint Navigation
Navigation is the ability of the program to guide you to a destination. This is a key feature of you 
WayPointtm software. In its simplest form, it is just an arrow pointing the way toward the 
destination. This was shown in the GPS display “Getting Started with Navigation ” on page 38 
where a direction was shown ‘as the crow flies’. A slightly better version of this air line navigation 
is represented by the pilot data pane which can be found on the Tools > Navigation menu. It 
looks like this:

         

Speed Heading Bearing Range Compass
Current 
speed

Direction 
of travel

Direction to the 
destination

Distance to the 
destination

Shows the direction 
needed to get to the 
destination

This is called the pilot data pane since it is perfect for a pilot. It is also useful when you are on a 
commercial airline that permits you to use your GPS. On the ground, you may wish to use it to 
display your speed or for Geocaching. For more see “Geocaching” on page 103.

Road Navigation
Most users a likely to want something a little more capable of guiding you for road navigation and 
this section covers these features. 

The display on the next page shows the WayPoint software providing turn-by-turn instructions 
on the screen. In this case, there are two turns coming up that are very close together. The 
program senses this and displays both turns to alert the user. Normally there will only be one turn 
indicated in the navigation pane. 
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Note that when the user selects turn by turn navigation by calculating a route this navigation pane 
will replace any other selected pane as soon as the system needs to display a message. When the 
message time is over it will revert to the previous pane you have chosen. You can rotate through 
all of the available panes by using the cursor keypad, either up/down or left/right will work.

There is a user option to control the size of the navigation pane. 
The smaller of the two sizes is shown in the picture. If you want to 
see the turn data at a glance you may prefer the larger display that 
covers up most of the map.

Voice prompts accompany the visual data and allow you to keep 
your eyes on the road. The voice prompt repetition frequency 
near a turn is adjustable. There is also a Turn Assist provided by 
the Alarm lamp on the front of the unit. When the turn message 
appears the lamp will start flashing. As you near the turn the flash 
rate will increase to indicate that the turn is closer.

Navigation Pane

Some of the power of this banner display may not be obvious at 
first. For example, suppose you are stopped and wanted to study a difficult turn that is still quite 
a bit ahead of you. You can scroll to the route pane which shows the full turn instructions. You 
can use the other pair of cursor pad presses (left/right if you used up/down to bring up the route 
pane) to walk you through the various turns in the route providing the full turn instructions and 
the map for that particular turn. In this example you would use up/down to switch out of this 
pane. Note that the route instructions will be available if you lose the GPS lock, your GPS is 
turned off, or you are not using a GPS.

 If you tap the full screen icon in the lower right corner to remove the navigation pane, you 
can use the cursor pad to scroll the map. This will work even if you are selecting a different place 
on the route. Tapping the icon again will turn the pane back on. It will also come back on 
automatically if you can configured this in your navigation settings.

ETA

The bottom of the pane can show an optional line 
that contains the time to go and the distance to go as 
well as the estimated time of arrival, ETA. 

ETA is computed based on the distance to go and the speed classifications of the roads on the 
route. It generally does a good job of providing the answer to the question: “When are we going 
to get there?” It is updated as the trip progresses. It is also useful in showing the cost of a traffic 
jam in time lost by comparing the new ETA with the earlier prediction.

ETA is displayed based on your local time setting. If the destination is in another time zone you 
can use the Visiting entry on the clock settings (Start > Settings > System > Clock) to set the 
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destination time zone. This will cause both the ETA and the internal PDA clock display to use 
the Visiting time zone value.

In the illustration the ETA line is shown with the Turn Reminder pane which is a nice choice 
when you wish to show a good deal of navigation information but want as large a map as 
possible. You can also choose to show only the ETA line, or no data at all.

Building a route
To build a route using the loaded maps, you only need to supply a starting location and a 
destination. Often the starting location is the current position as determined by the GPS so you 
only need a destination. The automatic router will find the path from the starting point to the 
destination.

There are two approaches to route creation. From the Tools menu they are called Navigation 
and Find.

Direct Navigation

 Tools > Navigation > Find Route is the more direct approach. It takes you straight to 
the Find Route screen where you can choose the Starting point, choose the Destination, and kick 
off the route by tapping ok. If there is no existing route then the same command can reached 
more easily from the Detour button.

Choose Either Starting Point or Destination to bring up a menu that contains:
Select Address Full or partial address will work 

here
Select Landmark This includes all points of interest 

and user defined landmarks
Select Intersection Two cross streets
Select Contact From your address book
Find on Map The graphical approach – The 

map should be displaying the 
correct place before the Find 
Route is given.

Use GPS Position current location - default if no 
starting point is specified.

Once the route has been generated the Return to choice permits you to control what appears. 
Choices include: First step - to zoom to the start of the route, Whole Route - to show the full 
route on the map, or Directions - to show the text directions for the route.

When choosing you starting point or destination you will a menu that contains the choices in the 
table above and a list of your favorites. The first three choices all bring up similar screens to enter 
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the required data. Of course the individual data on the screens is different but approach is the 
same. 

The address screen is shown at the left as an example. 

You can search the entire database or you can restrict the data 
geographically or by category or both. You can restrict the search: 

• To a distance within 25 miles of your location 

• To an area that is displayed on the screen 

• To a zip code

• To a city 

Other specific Step by Step flows can be seen in Chapter 7, “Step-
by-Step” on page 65

An important feature that is easy to overlook is on the View menu item shown on the command 
bar. 

• You can sort the results alphabetically or by distance. 

• You can also choose to show the distances and address in the search results. 

Being able to sort the results by distance means it is easy to find the next filling station or 
restaurant depending on whether the car or you are hungry.

T H E  S E A R C H  

Selecting a category or specific street data will cause the program to start searching as indicated by 
the appearance of the spy glass icon. This icon will blink while the search is in progress. 

• You can further limit the search with data in the third field. It is ok to add data while the 
search icon is blinking. 

• As soon as you see the data you want tap ok. When the search is complete the spy glass 
icon will disappear.

Select the Origin menu on the command bar to tell the program where it is to search. You can 
restrict the area based on the map view, the GPS location, or any of your favorite locations.

Searching for intersections is a two step process. First search for one street and the unit will offer 
a list of choices for the second street that intersect the first. If you don’t see what you want, try 
reversing the entries.
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C O N T A C T S  S E A R C H

Selecting Contacts lets you search through your address book. The WayPointtm software will 
copy a list of the address book entries to a form within the program. Specific Step by Step flows 
can be seen in Chapter 7, “Step-by-Step” on page 65. 

• There must be an address listed for you contact for the address search to work. 

• If there are two addresses it will present the choice of work or home. 

• Select the address you want and tap ok to begin the search. 

Occasionally the form of the address in the address book will not match the form needed by the 
WayPoint software. If this happens the location will be identified but the search will fail. You can 
try editing the address entry being shown on the search screen to give it a clearer address. 

Generally the search works best with less data. One wrong character will cause the search to fail 
but leaving out letters or even whole words will not be a problem for the search algorithm. Once 
it presents a list of possible choices you can simply select the correct one.

If you are able to find the address this way you might consider using the displayed form in your 
contact list so that future searches will be successful.

The Quick Approach

There are two hotkeys preprogrammed to facilitate quick routing.

ROUTE TO FAVORITES

Tap the Favorites  Button to navigate to one of your favorites. Selecting one from the list 
will kick off the router and route to that location from your current location. You must have a 
GPS fix for this to work. Specific Step by Step flows can be seen in “Step-by-Step” on page 65.

TAKE A QUICK DETOUR

If you are driving and need some Gas or Food the Quick Detour function can be handy. It is also 
a good way to find close by locations.

Press and hold the detour  button for a couple of seconds and the category screen will 
appear as shown on the next page.
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Tapping one of the icons will bring up a short list of locations matching the category along with 
their distance and direction. In the example shown above on the right the nearest gasoline 
stations are shown. 

• The name of the business as well as the direction will be shown as you might want to 
skip those that are behind you. 

• Note that if you are stopped the GPS may not be reporting the correct direction so it is 
best to do this command while you are moving. 

• If you don’t have a fix the unit will tell you cardinal directions to the location rather than 
relative direction.

• Tapping an entry will route you to that location.

• If there is not a check mark by your choice you may want to increase the radius.

This is a quick way to choose from among your favorite categories and will only offer choices 
that are within a prescribed radius of your location (or an origin that you choose). 

As shown the check marks indicate that there is an entry for that category available.

The search radius can be defined from ¼ mile to 20 miles in approximately 2X increments using 
the Radius menu on the command bar. The value is remembered once it is set.

Specific Step by Step flows can be seen in Chapter 7, “Step-by-Step” on page 65. 

It is not possible to show all of the categories in the database but this screen can be customized to 
show the ones you wish. If you tap and hold on the category you will be able to change the 
category to any of those available in the database. You may want to keep important and useful 
categories on this screen. 

• Getting to a Gasoline station in a hurry could be a high priority.
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• Finding a Restaurant is usually one that you would want to keep.

• Route to nearest can be really useful for getting to a hospital or the closest police station. 

• The category list even includes those from your own Landmark database.

The Find Approach

The Find approach is used when you wish to find and display the 
object on the screen and then call the router. This method is a little 
more flexible if you aren’t sure which of the many locations in a 
chain of stores you really want. 

Many of the most used find commands plus a list of your favorite 
locations are available from the signpost icon on the command 
bar. All of the choices are available from the menu. 

Click Tools > Find to bring up the menu of the full find options. 

Once you have found the object you are interested in it will be 
shown on the map. You can tap it and then tap the description to set it to the starting point or 
the destination.

 
Find > Latitude/Longitude is useful for looking at a location that matches a paper map.

Find > Favorites is one of the choices on this menu. The favorites list can be managed with this 
command. Items can be moved around or deleted. The Favorites list is also available by pressing 
the favorites button. The favorites button choice will kick off a route to the favorite location. 

The Find > All places by Type choice brings up the same screen and holding the Detour 
button down for a second. However, in this case it will bring up a map showing nearby locations 
that match the category chosen. This is a great way to just scan through the “yellow pages” 
graphically for something you might like. Just set up a radius and then select the type you want. 
The map will appear with all the points of interest for that category highlighted with their icons. 

See “Step-by-Step” on page 65 for examples showing the use of most of these search choices.

Your personal locations can be searched as well although they are not on the find menu. Use 
Tools > Landmarks > Show locations to bring them up. You can select categories similar to 
the ones for points of interest or you can make up your own. Items can be edited or click to 
‘goto’ to center the location on the screen. It is then a simple matter to make it the destination 
using tap and hold.

 Once you have used find to pick your spot you can tap the detour button to bring up the 
Find Route form. It will have the destination you selected already filled in. Alternately you can 
use the Navigation > Find route command to automatically route to it by tapping ok. 
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The Route

Once you have generated a route you can look it over or just start following it. You can also 
revisit the Tools > Navigation > Find Route command to:

• save the route for future use. to 

• reverse the route to get back home. 

• Recall a route you saved earlier. 

Recall and reverse route do not try to use the whole route you set up earlier. Instead they simply 
use the start and finish points plus any ‘route through’ points (described below) to generate a new 
route.

G U I D I N G  T H E  R O U T E R

If you don’t like the route that the program chose you can request a modification. When a route 
is active you can click on a place on the map and tell the router you want to route through that 
location. Press and hold on the description to reach this choice. 

This is a powerful tool that will guide the router to go in the way you wish. These intermediate 
points are saved when you save the route so they are completely reusable. You only have to tell it 
once. 

Multiple route through locations can be added to the route. Multiple locations would allow a 
complete route to be set up with multiple stops.

When a route through location is determined a small circle is added to the road at that point. This 
circle can be tapped to remove the route through point if desired.

ROUTING OPTIONS

Another way to guide the router is through the Tools > Settings > Routing options. You have 
control over the router in that you can tell it how quick to produce results. Thus, you can trade 
off calculation speed that may not find the optimum route for a more exhaustive approach. 

Routing with fastest selected causes the Router to use the speed of the road in determining the 
best route. When routing using the shortest route the router assigns all roads to the same speed. 

You can tell the router to avoid toll roads to save money when other routes are just as good. The 
other choices are shown in the table on the next page:



Freeway Use       
                  

Fastest Route Shortest Route

Neutral to Freeway 
use

Normally the best choice Provides an alternate route.

Prefer Freeway Good for travel through a bad 
neighborhood. Likely to 
compute results more quickly.

Good choice in outlying areas 
where the road classification may 
not be correct.

Avoid Freeway Good for taking the scenic 
route. Use for motorbikes.

Best for walking or bicycling
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The Directions Screen
When a route is active the cursor buttons can be used to scroll 
though the various turn instructions. There is also a route screen 
that can be used to see the full instructions. This screen can be 
reach from Tools > Navigation > Show Directions menu. 

The directions screen shows each of the turns with distance and 
turn details. A trip summary appears at the end of the list showing 
the distance and estimated driving time. The directions can be 
saved as a file and beamed to your friends in a caravan.

The route can be scrolled using the cursor key to show each and 
every turn. The numbers show exactly how many turns are 
required. They are live in that if you tap on them they will display 
the map showing the turn. 

If you are navigating and bring up the directions screen the current leg of the route will be shown 
at the top of the screen.

Tapping ok will return to the active map screen.

Navigating the Route
Once you are satisfied with the route, you can just start following it. Even if you are not 
completely happy you could just start driving anyway. The WayPointtm software will detect when 
you are off route and will generate a new one from your current location so eventually it will 
route the way you want to go whether you went off route intentionally or by accident.

The main features of the route guidance features were covered in “Road Navigation” on page 54

Detours 

 The detour button can be used to generate a detour if you get into a traffic jam or find the 
road impassable. Tapping Detour will bring up a table of choices for the distance to avoid. These 
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include ¼, ½, 1, 2, 5, and 15 mile increments. Tapping one choice will cause the router to 
regenerate a route that tries to avoid the specified distance or so of the current route. (Remember 
that the thumb wheel can be used to perform the selection.)

• On a normal surface street this may cause the router to request an immediate U-turn. 

• On a freeway it will initiate a route that takes the next exit. 

• It is possible that the route that takes the exit may just route the unit right back on the 
freeway, particularly if you were quite a ways from the exit when you tapped it. Selecting 
a longer distance will help prevent this. 

• But if you see that the freeway is still clogged just press the detour button again when 
you get to the crossroads of the interchange. This will cause the router to avoid the 
entrance ramp just ahead. 

• The detour button is designed to be interactive. It can be pressed as many times as you 
wish to try out the alternatives. Each time you press the detour button it starts over 
from your current position and does not remember items from the previous time you 
pushed the button. It is likely that it may find the original route again under some 
conditions.

The detour button can also be used to silence an annoying re-routing message. If you decide to 
change the route just be driving off the current route the voice prompt can sometimes take a long 
time to determine that you really wanted to change the route. Tapping the detour button will tell 
the program of your real intentions.

Other Navigation features

You can also suspend the route if you wish and return to it later by tapping the command  
Tools > Navigation > Active Route Guidance. Pressing the detour button will turn it on 
again.

When Navigation is on the WayPointtm unit will warn you about upcoming turns by voice and a 
flashing light. If you have the navigation pane on you can see the turn instructions. The amount 
and frequency of the announcements are customizable on the Navigation Settings form. The 
voice instructions and the flashing light will occur even if you suspend the program to look at 
something else or even run a different program.

You can press and hold the status  button for a second at any time to hear a message about 
the next turn. It will tell you the distance to the turn and direction of the turn.

If, for some reason, the GPS reception is lost the Navigation pane reverts to showing the route 
turn instructions so you can continue to use the map and route instructions. A Red panel appears 
to alert you to the fact that GPS reception was lost and the doughnut icon showing your last 
position will turn red. When GPS reception is regained the navigation will begin from wherever it 
finds itself. You might have to tap the banner to get the GPS position back on the screen.
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Customizations

There are many customizations to permit the guidance to be tuned to the user’s preferences. 
These include the already mentioned Voice prompt settings as well as changing the size of the 
navigation pane, making it automatically appear, showing the ETA (Estimated Time of Arrival), 
as well as some GPS options. ETA is a really useful banner for predicting arrival times. It uses the 
speed data from the road classes to predict an arrival based on the remaining distance. To ensure 
that the GPS and PDA agree as to what time it is the PDA will automatically be set to GPS time.

The GPS options of particular use while navigating include 

• auto-scroll - to keep the GPS location on the screen.

• auto zoom - will zoom in near a turn and back to the user preference after the turn.

• auto-rotate - to keep the cars current direction toward the top of the screen.

• lock to road - This changes the behavior of the GPS position indicator.

• center the view forward - offset the display to provide more data ahead.

SOUND SETTINGS

Sound settings include customizing the beeps and sounds associated with various navigation 
notifications. First turn, Turn Coming, Turn Complete, Re-route sounds can be customized. 
There is also a setting for Special Notices.

In addition notifications are available for GPS change in status. Fix acquired and Fix lost can be 
set independently.

The various sounds can also be turned off if desired. Sound choices include standard Pocket PC 
alarms and unique WayPointtm navigation sounds.

Speed alert can be set to sound at a specific speed. 

Voice volume can also be changed here or by using the system volume settings. You can choose 
from the available voices depending on what you have loaded. TTS (Text To Speech) is a special 
voice that permits the unit to say the turn message itself. You can tune the speed of the voice to 
aid in understanding it.
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Chapter

7
Step-by-Step
This Chapter contains step by step samples to do specific tasks in the WayPointtm navigation 
software.

Quick Routes
Quick Routes always route from your current location.

Route to a Favorite Location

  

You can generate a route to any of your favorite locations.

1. Press the Favorites Button

2. Select a location from the menu that appears. 

You must have a fix for this to work.
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 Quick Route

 
You can generate a route to the nearest Gas Station or the Nearest 
Restaurant. or other specific category.

1. Press and Hold the Detour button for a second.

2. Tap the category you wish.

3. A menu will appear for you to select from a list of close by 
locations. The direction will be indicated as shown below. The 

check marks indicate that there is a nearby entry for that category. 

4. Tap the one you wish to generate a route to that location. 
Tapping outside the box will cancel the command.

The categories shown on this screen can be customized to be any 
available category in the database. 
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Other Routes

 For other routes you need to start with the Tools > Navigation > Find Route 
command. If there is no route active it can be found on the detour button which normally does 
the detour command when you are navigating a route.

The first steps are always the same.

        

1. Tap the Choose Destination

2. Select a Choice from the menu. 

Notice that your favorites are listed among the choices. If the Find Route form already has data 
on it from a previous route then you will also need to tap the Choose Starting Point to change 
it. Choose Use GPS Position for the starting point. 
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Route to an Address

Perform the first two steps above and tap Select Address.

             

3. The top left corner box contains a selection. Choices include Within 25 Miles, Anywhere, 
Current View Area, A list of all loaded towns, and a list of all loaded zip codes. Pick what 
you want. You can enter the first letter to aid in searching the dropdown list.

4. Enter the search data using any of the available entry methods. You can start with the 
number or the street name. The Search spy glass will appear to show that a search is in 
progress.

5. When addresses begin to appear you can scroll to select one or just enter more data to 
trim the list. Scrolling can be done with the scroll bar, the cursor key, or the thumb wheel 
but you will need to tap the field to scroll since the top field can also be scrolled.

6. Tap OK with the one you want highlighted. The list can be sorted by nearest or in 
alphabetical order.

7. Tap OK on the route form to kick off the route.
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Route to a Landmark

Perform the same two starting steps and tap Select Landmark. A landmark can be a point of 
interest, Business, Rest Area, Government facility, Tourist Attraction, or some place you saved in 
your own locations database. 

3. The top left corner box contains a selection. Choices include: 

• Within 25 Miles. 

• Anywhere.

• Current View Area.

• A list of all loaded towns. 

• A list of all loaded zip codes.

Pick what you want. Entering the first character can help to 
move rapidly through the list.

4. Tap the category or name field to limit the choices.

         

5. Select the Category you wish. You can move more rapidly through the list with the 
keyboard by entering a few starting letters. You can also tap this entry field and use 
the cursor key or thumb wheel to move through the list.

6. Find the one you want, either scroll for it or enter a few characters in the name field. 
The name field also has a pull down list of recent places you picked.

7. Tap OK with the one you want highlighted. The list can be sorted by nearest or in 
alphabetical order

8. Tap OK on the route form to kick off the route.
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Route to a Contact

You can route to an address in your contact list. Perform the same first two steps above and tap 
Select Contact.

        

3. Select the correct entry from your contact list. You can scroll or search the list. If 
the entry has two addresses a second button will appear to permit you to choose 
which one you want.

4. Tap ok to allow the program to search for your address. If successful a list of choices 
will appear on the next screen. If you get a no match error you can try to modify the 
address a bit. For example, you might pick a different town or edit the street name. 
Remove any suffixes on the address and apartment numbers.

5.  Once you have the correct address selected, tap OK to return to the route screen.

6.  Tap OK on the route screen to generate the route.



71

Finding Locations
Another approach to routing is to find the location first. This is especially useful when you aren’t 
sure of the location name or haven’t quite made up your mind yet.

Finding a Location Graphically

You can find a location graphically and then route to it. Let’s suppose you are driving east on I-80 
somewhere near Fairfield and decide you need gas. Here is one way to proceed.

1. Select Tools > Find > All Places by Type. This will bring up the screen shown 
below on the left. (Note that this screen also appears in the “Quick Route” on 
page 66 command description but the subsequent behavior is different.)

          

2. Select the radius you want to search or take the previous one you used. The check 
marks indicate that there are entries for that category within the radius chosen.

3. Tap the Gas/Service Station icon.

4. A screen showing all the gas stations in the radius you chose will be shown. You 
can tap any of them to find out what kind of station they are and their locations are 
clearly shown on the map. Don’t forget to look at the small dots as well. These are 
stations that are too close together to show the big icon. You can zoom or pan until 
you find the one you like.
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5. Once you have one in mind tap and hold on the 
description to bring up the menu.

6. Selecting Route To will generate a route to that 
location. Or, if you’re already running a route, 
consider Route Through to add the gas stop to the 
existing route. This will route to the station and then 
back to the route you were already on.

Using the SignPost

The SignPost quick find icon is near the right end on the 
command bar. Tapping this will bring up the quick find menu 
shown at the left. This menu contains some frequently used find 
commands and a list of your favorite locations.

1.  Tap the sign post icon.

2. Select the entry you are interested in.

3. Once the location appears on the screen, use the tap and hold 
technique to bring up a menu.

4. Select Route To to kick off the router to route to that 
location.



73

M
ap

 L
oa

de
r

Chapter

8
Map Loader
Your WayPointtm unit comes with 128 megabytes of Flash Disk space for maps. While this will 
not hold the entire United States, it will hold one region and perhaps the long haul maps. The 
long haul maps contain major road maps of the entire USA. The next figure shows the 
approximate boundaries of the regions. Note that region R is Canada. For detailed data see 
“Region Coverage” on page 80. 

The WayPoint Map Loader is a program that comes with your WayPoint PDA. It manages the 
map regions that are used by the navigation software and facilitates map purchases. The 
WayPoint Map Loader provides the following functions:

• Manage maps on either the built-in Flash Disk or a user supplied SD card.

• Identify which regions are owned by the user and available to be loaded on the unit.

• Show which regions are already loaded on the unit.

• Unload or reload any region as needed by the user. The source maps can be on a card or 
they can be retrieved from the Internet.
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• Purchase maps.

Using the Map Loader permits the user to keep maps they are using separate from maps that they 
own. This improves performance of the mapping software while providing flexibility for the 
user. Maps that are not needed can be on a CompactFlash card, an SD card, or readily retrieved 
from the Internet at any time. They are compressed to save storage space and to reduce 
download time from the Internet. Loading a region to your Flash Disk area can generally be done 
in less that 15 minutes from a Map Loader equipped CompactFlash card.

The WayPointtm unit’s source maps are freely available as a download from the Mobile Crossing 
web site and from other media formats for about the cost of the media. However, to use the 
maps you will need a Map Activation key. This key provides the license to use the maps. It is the 
key that is actually purchased.

Map Loader Overview
The intent of the Map Loader program is to provide an easy to use method to purchase new 
maps and manage those that you already own. Managing maps is a two step process.

1. Purchasing the Map Activation key.

2. Loading the maps onto your PDA.

The purchasing step can be done entirely via the Map Loader program if your PDA has an 
Internet connection. If you do not have an Internet connection on your PDA you can use the 
Map Loader in combination with our web site, http://www.mobilecrossing.com, to purchase 
maps. If you don’t have web access you can use the Map Loader in combination with a phone 
call to purchase maps.

Starting the WayPoint Map Loader

To start the WayPoint Map Loader follow these steps:

1. From the  Start menu select Programs > Map Loader. Alternatively, inserting a 
Mobile Crossing Map Loader card will start this tool automatically

http://www.mobilecrossing.com
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2. Tapping Next will bring up one of four screens. Compare the screen you see with the 
images below to determine which step to follow.

 Go to Step 3   Go to Step 4  Go to Step 5 Go to Step 6

3. You will see this screen if you forgot to install your Map Loader card and have never 
downloaded maps from the Internet. Follow the screen instructions to get a file list. Once 
you have obtained the file list you will go back to step 2. For more information see “File 
List lost” on page 89.

4. You will reach this step if you do not have an Internet 
connection and you have never activated a map before or 
your activation key is corrupt. If you have never activated 
a map please go to “Purchase Map Activation key” on 
page 77. Otherwise go to “Map Activation Problems” on 
page 88

If you think this screen should not have appeared 
please check the section “Problem Resolution” on 
page 87.
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5. If you have an Internet connection the authentication 
screen will appear briefly and then switch automatically to 
the main menu screen (step 6).

6. The Map Loader main menu is shown in to 
the left. 

21

3 4

This is where you will decide what you 
want to do.

If you thought you were on the Internet and 
do not see the authentication screen of the 
previous step you should tap EXIT and see 
“Problem Resolution” on page 87 before 
restarting the Map Loader.

The program is fully functional without an 
Internet connection but some tasks can be 
automated if you have a connection.

The Main Menu

The task available from the main menu include:

• (1) View/Build Base Map - This command loads maps into the Flash Disk area 
on the WayPointtm unit. It also shows which region is currently loaded and 
manages the map area permitting you to swap loaded regions.

• (2) View/Build Map Card - This command permits loading maps into the card 
plugged in the SD slot on the WayPoint PDA. It also manages the maps that are 
loaded on the SD.

• (3) Map Tools - This command is where you can go to purchase maps and 
perform maintenance tasks such as repairing map related data on the unit. More 
information on using Map Tools can be found in the section on “Problem 
Resolution” on page 87.
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• (4) Exit - This command will shut down the map loader. The user can also use 
the Cancel command available at the bottom of most screens to shut down the 
map loader.

Purchase Map Activation key
You need a Map Activation key before you can load maps into your unit. The source maps 
themselves are not useful without the activation key.

Purchasing the Map Activation key can be done three different ways. These include using the 
Map Loader directly, using the Mobile Crossing web site, and by phone.

If you have never activated a region before the first region will be free. You will still use the 
appropriate process in this section to receive access to your free region.

There is only one Map Activation key needed for the unit. If you own multiple maps this 
information is contained in the one key. If you purchase a new region you will get a new key that 
replaces all previous keys. The key you receive will only work on one unit.

Order Using the Map Loader program

If you have an internet connection the process will be simplified since the device identification 
code and the map activation key will be transferred automatically as needed. You will be able to 
do everything from within the Map Loader program. Use the process shown in “Starting the 
WayPoint Map Loader” on page 74 to start the program. 

The following steps in the Map Loader can be used to Purchase one or more regions:

1. Tap the Map Tools entry on the main menu to bring up the Map Tools menu and select 
Purchase Maps. The screen shown below will appear

               

2. Choose one or more map regions by selecting them from the drop-down menu at the 
top of the screen. Tap the Add to Cart button to place the ones you want in the 
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shopping cart. The name of this button will change to Remove from Cart. The region 
you selected will be added to the Select Maps. The total price of the purchase will be 
shown. The descriptions for each region is shown in the Region description chapter.

Tip: If you tap the map regions drop-down menu twice it will remain selected. You 
can use the thumb wheel or cursor keys to scroll through the list. This is often easier 
to control that try to scroll the list with the stylus.

The New Version button will appear if there is another version of the maps 
available. You do not need to upgrade when a new version is available but all loaded 
maps must be of the same version.

3. When you have selected the maps that you wish to purchase tap the Next entry at the 
bottom of the screen. This will bring up the review purchase screen shown at the top left 
of the next page. It lists all of the regions you have selected and the total price.

                

4. When you are ready to complete your order tap the Purchase entry at the bottom of the 
screen. This will bring up the secure data entry screen show above on the right.

5. Fill in all of the data on the form. Some of the data will be pre-filled from your 
WayPointtm PDA owner information. For credit card purchases please ensure that the 
Cardholder’s name matches the name on the card. Also ensure that the address is the 
billing address for the card. The E-mail address will be used to send you confirmation of 
the order and verification of your map activation key for your records.

6. If you are not purchasing your “free” region you will need to enter your credit card 
information. At the time of this writing we accept Visa, Master Card, American Express, 
and Discover. The Card Security Code is on the back of the card.

Note that PayPal is not supported here but can be used for Web purchases. See 
“Order Using the Web Interface” on page 79.
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7. Tap Submit to complete the purchase. The data will be sent via a secure connection and 
validated. If there are any errors you will be given an error message so that you can 
correct the data and try again. Your map activation key will be downloaded and installed 
in the unit automatically once the information has been accepted. A confirmation E-mail 
will be sent which contains the map activation key for your records.

You can return to the main menu to install your new maps or you can exit and install them any 
time later.

Order Using the Web Interface

The Web interface permits you to enter the data yourself. If you have cookies enabled on your 
web browser some information can be saved on your local machine so you won’t have to reenter 
it after the first time. The steps are as follows:

1. Tap the Map Tools selection and tap Repair Activation key. This will bring up the 
device identification code. This is shown in Table 1 on page 79.

2. Use your web browser to view the Mobile Crossing web site and select Purchase Map 
Activation Key from the Map Store menu.

3. Enter the data from your PDA screen into the screen on the web site. Click Submit and 
follow the on screen instructions to purchase the maps you want.

The web site accepts payments from PayPal, Visa, Master Card, American Express, 
and Discover.

Figure 1. Displaying the Device Code
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4. Once you have purchased your map activation key you 
will need to enter it into the PDA. Tap Next to bring 
up the activation screen shown on the right.

5. Enter the 25 characters from the Web display to the 
PDA and tap Next to check for errors. The maps you 
purchased are now activated. You can proceed to “Map 
Loading” on page 83.

Tip: If you can get an Internet connection with your 
WayPointtm PDA but chose to buy your maps on the 
web for some reason, such as PayPal support, you can 
still use the Map Loader to enter the activation key 
and avoid having to enter this data manually. Start the 
Map Loader while online and use the Repair Activation key command to 
automatically enter the data.

Order Using a Phone

This is the least automated method. To use this method you need to start the map loader and go 
to the main menu page. Then follow these steps.

1. If you don’t have the Device Identification code screen showing on your PDA tap the 
Map Tools selection from the main menu and tap Repair Activation key. This will 
bring up the device identification code. This is shown in Table 1 on page 79.

2. Now, with your credit card or PayPal number ready, call the number and order your 
region. The operator will ask you exactly the same information that would be required by 
using the Web site method. This includes, the desired region(s), your name, address, and 
credit card number (unless you are ordering a free region).

3. Once you have ordered your region or regions you will need to enter the activation key 
into your unit. Tap Next on the Map Loader to show the activation screen as shown 
above.

4. Enter the 25 characters and tap Next to check for errors. The maps you purchased are 
now activated. You can proceed to “Map Loading” on page 83.

Region Coverage
The regions shown on the next few pages are available from Mobile Crossing. The illustrations 
are shown for version 2 maps. Region definitions may change slightly with each new release due 
to updated data needing more space. The WayPoint PDA can hold one region without the need 
for additional storage. Generally the long haul maps will also fit but this is not guaranteed. The 
long haul maps are a free region and permit long distance routing between two regions that are 
otherwise not connected. It is possible to install a region in the Flash Disk area and another 
region on an SD memory expansion card. The long haul maps are recommended for routing 
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between sets of otherwise unconnected regions. Regions generally include one or more adjacent 
states but may also include partial states (adjacent counties) to improve usability.

Region Descriptions

The standard regions include:

Blue Grass
Indiana 
Ohio 
Kentucky 
West Virginia

Cajun South
Tennessee 
Alabama 
Louisiana 
Mississippi 
Georgia-NW 
Arkansas-NE

Central Midwest
Indiana 
Illinois 
Missouri-East

Great Lakes
Michigan-Lower 
Ohio 
Indiana

Lone Star
Texas

Mid Atlantic
Pennsylvania-Eastern 
Delaware 
MaryLand 
Washington DC 
New Jersey-Western 
West Virginia-NE

Mideast
Ohio 
Pennsylvania 
West Virginia-North

Midwest
Kansas 
Missouri 
Oklahoma 
Arkansas

New England
Maine 
New Hampshire 
Vermont 
Massachusetts 
Rhode Island 
Connecticut 
New York-Eastern

North Central
North Dakota 
South Dakota 
Nebraska 
Minnesota-East 
Iowa 
Montana 
Wyoming
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Special Regions

There is a Long Haul region that contains major road maps for the entire United States except 
Alaska. Puerto Rico and Washington DC major road maps are also included. The region is free 
to all users.

National maps include detailed maps of all the areas covered by the Long Haul region.

Great Lakes region is a duplicate in that all of the states in that region are in other regions. It is 
provided as a convenience for the folks living in that area. All other regions have at least one state 
that is unique to that region.

Pacific
California 
Hawaii

Pacific Northwest
Washington 
Oregon 
Idaho 
Alaska 
Utah-North

South Atlantic
North Carolina 
South Carolina 
Georgia

Southeast
Georgia-Southern 
Florida 
Puerto Rico

Southwest
Utah 
Colorado 
New Mexico 
Arizona 
Nevada 
Wyoming-Southern

Tristate
New York 
Connecticut 
New Jersey

Upper Great Lakes
Minnesota 
Michigan 
Wisconsin

Canada New Brunswick 
Newfoundland 
Nova Scotia 
Ontario 
Prince Edward 
Quebec 
Alberta 
British Columbia 
Manitoba 
Northwest Territories 
Saskatchewan



83

M
ap

 L
oa

de
r

There is also a region for Canada. It includes the following provinces and territories: New 
Brunswick, Newfoundland, Nova Scotia, Ontario, Prince Edward Island, Quebec, Alberta, 
British Columbia, Manitoba, Northwest Territories, and Saskatchewan. It also includes all of the 
Long Haul maps for Canada.

Map Loading
You can install any map set that you have previously purchased. The maps can be obtained from 
a CF card, an SD card or directly from the Internet. Mobile Crossing has a 1 Gigabyte CF card 
available with all of the US and Canada maps preloaded. You can also build your own card if you 
prefer.

Using the Internet

If you have an Internet connection on your WayPointtm unit you can use this connection to 
download maps. Generally a broadband connection is needed to minimize the download time. 
You will be downloading more than 70 Megabytes of data in multiple files. No single file will be 
larger than 4 Megabytes. Should you lose your connection during the download this will be 
detected and you can recover and continue with the download.

Using a card

If you have a CF or SD card available containing the source map files you can use this card to 
install the maps you have purchased. Mobile Crossing offers a 1 Gigabyte CF card containing all 
of the maps. If you build your own card and accidently miss some of the files the program will 
detect this and offer to download them from the Internet. It is possible to mix source map files 
and loaded map files on the same SD card. 

MAKING YOUR OWN MAP LOADER CARD

This section is only for advanced users who know how to work directly with the file system on a 
pc. To minimize the time to build a Map Loader card you may wish to utilize a card reader. You 
may also need an unzipper depending on how your get your source maps.

1. The first step is to obtain a card and place a directory called WpMaps on the root of the 
card. All of the source maps will go in this directory. The card can be either a CF card or 
an SD card. Do not create a second WpMaps inside the WpMaps directory.

2. The second step is to obtain a set of source maps. These can be regions downloaded 
from the web site or obtained from a CD-ROM. You may also be able to get these from 
a friend. If they are zipped you will need to unzip them and copy the contents into the 
directory created in step 1. The maps must go directly into the WpMaps directory.

3. You will also need two files in this same directory. These are the FileIndex.xml and the 
FileIndex_short.xml. These files are in a separate zip file that should be downloaded and 
unzipped into the same place. These files are also located on the Flash Disk if you have 
ever downloaded any files from the web site and may be copied to the card.
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4. Once the files are located on the card you can use it for map loading just like the one 
purchased from Mobile Crossing. (The one from Mobile Crossing may contain extra 
features such as autorun.)

Note that there may be duplicate files in the various regions. They are identical and can be 
overwritten if you wish when making the copies.

Map Loading Steps

The steps to load a map are described in this section. The program itself will sense the Map Card 
and use it if it is available. Otherwise the program will attempt to retrieve the maps from the 
internet. If you have a Map Loader equipped card please insert it before beginning the process. If 
you will need an Internet connection, it should be established before starting Map Loader.

1. Use the process shown in “Starting the WayPoint Map Loader” on page 74 to start the 
program and use the Next commands to move to the Main Menu.

2. From the Main Menu select the destination for the maps. Tap Build Base Map to place 
the maps on your Flash Disk. Tap Build Map Card to place the maps on your SD card. 
Once you have selected the destination a screen will appear to allow you to select the map 
region you wish to load. This is shown at the top of the next page.

                   

3. Use the drop-down menu to select one of your available regions. All of your purchased 
regions will be shown, even those you may have already loaded. The loaded regions will 
be shown on the bottom map. In the figure above the screen is showing that Pacific 
region and the Long Haul maps are already installed while the Bluegrass region is 
selected. Clearly this is too large to fit in the Flash Disk area.

4. If the region you want to install is too large then you will need to remove the existing 
maps. Use the pull down menu to choose one of the installed regions and the button 
name will change to uninstall map. Tap Proceed to uninstall the map.
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Tip: If you tap the map regions drop-down menu twice it will remain selected. You 
can use the thumb wheel or cursor keys to scroll through the list. When you reach the 
installed map the Uninstall Map button will appear.

If removing maps does not solve the problem with space you will need to use the File 
Explorer program to remove files. When you tap to leave the File Explorer and 
return to this page you can tap OK to reload the screen so that the free space will read 
correctly.

5. If the region fits you can tap Proceed to copy the maps to your Flash Disk or SD card. 
An example is shown at the top of the next page.

               

6. A progress bar will appear while the region is being erased or copied. A button will 
appear when the task is done. Pressing this button will return to the Main Menu screen. 
The progress bar will be slightly different if you are downloading the maps from the 
Internet. There will be two bars, one for each file download progress and one for overall 
progress.

7. If you get an error during the download or copy process or cancel the operation you will 
get a message saying “Some source files are missing.” If you get this error please check 
the error recovery section “Recovering Missing Maps” on page 89 for more information.

8. After a successful load you can exit out of the program and re-install your GPS or 
Bluetooth card and begin using your new maps. Or, you can load more maps.

Tip: Since removing one region to make room for another is a common task you can do both in 
one step. Simply select the one you wish to remove, select the one you wish to add and then tap 
Proceed. The Map Loader will do both the erase and reload in a single step. This trick will also 
work to load multiple regions in a singe step by selecting them all if there is room to do so.
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If you are removing a region that had missing files the amount of free space shown on the pie 
chart may be wrong since it is based on the known region size, not the actual files loaded size. It 
is always correct when you first enter one of the Build Map screens.

Using “Choose Map” in the WayPoint software
While the maps are now loaded onto your WayPointtm unit they 
may or may not be loaded in the WayPoint navigation program. 
If you removed your existing maps and loaded a full set of new 
maps the WayPoint application may start by showing you the 
Choose Map page since you will have no maps loaded that it 
knows about. Otherwise it will simply load the old maps it used 
the last time it ran and the new ones will not be seen. To select 
the new maps use the Choose Map command from the Tools 
menu.

It may take a little time for this screen to appear as it will need to 
search for the files. The top entry is a pull down list. It can be set 
to use maps only from a particular directory or from all 
directories on the WayPoint unit that contain maps. The 
Selection choice on the command bar will let you unselect all maps and controls the ability to 
select multiple maps. You will usually want more than one map displayed. You can tap as many 
maps as you wish and then tap ok.

If you have one or two regions loaded you may just want to display all of the maps. Use the 
Choose Map command and then highlight one or more maps. Tap the box beside “Also open 
all Contiguous maps” and tap ok. This will cause the WayPoint software to select every map that 
is adjacent to another map. This can select quite a few maps. If major road maps are selected in 
this process it will try and load every map in the entire United States that you have on your unit 
which could take several minutes just to load. If there are too many maps you may run out of 
memory resources to load them all. 

There may be times when you would prefer to not load them all. A few reasons include 
improved load times, improved route times, less system resources needed, and improved search 
times. This section will tell you how to work with the minimum amount of maps. You can 
restrict this behavior by not using the contiguous map check box or by limiting the search to one 
directory using the pull down at the top of the screen to select the directory you wish to use. You 
can also just load the Long Haul (major road) maps and select the detailed map you wish to load 
graphically. This is particularly useful when you are not familiar with the county names you may 
wish to load. See the section later on how to graphically select the maps.

Choose Maps

As mentioned you can select specific directories that contain maps. This can be done using the 
drop down menu at the top of the screen. If you choose a new directory any selected files from 
the old directory will be remembered. This feature allows you to have maps from multiple 
directories loaded without having to select all folders. To start over with map selection you 



87

M
ap

 L
oa

de
r

should use the Selection Menu and unselect all maps and then choose the maps you wish 
from the various directories.

The View menu permits controlling what information is displayed in the choose map screen. 
There is also a refresh command on this menu that will cause the unit to search storage and 
display the maps again. This can be used to tell the WayPointtm software about new maps if you 
load different maps using the Map Loader. The refresh command will also remove unselected 
maps from other directories if they are still present in the list.

Graphically Selecting Maps

To Graphically Select the maps you wish to use begin by loading the Long Haul maps between 
your home and your destination using the choose maps command. A special check box 
facilitates selecting the major roads. Use the magnifying glass icons at the bottom of the screen to 
zoom in (+) or zoom out (-) until you see a map you recognize which will be the major road map. 
Tap the square icon with the – (minus) inside until all you can see is roads and little sunbursts. If 
the city names are turned on these may obscure your selection. Change the map settings to 
remove these names. You can always tap to show the name.

You can hold the stylus against the map and drag the map around on the screen. Tapping any of 
the sunbursts will display the county name for that area. Tap and hold the stylus on the displayed 
name to bring up a menu that permits you to load that map. Load whatever maps you wish.

Note that maps you do not load will not be selected automatically by the program, thus if you 
drive into an area where you did not load a map there will be no map displayed. This is another 
good reason to always load the Major Roads map.

To load the minimum required for a route select the detailed county map at the start and at the 
destination. Try and use the road map for any of the routing that needs to be done between these 
two points. If your county is not connected to the road map then you may have to load an 
adjacent detailed map to make the connection. The route calculation will generally be faster with 
only these maps loaded. After the route is calculated you can add detailed maps graphically along 
the route if you wish to show the gas stations and other POI’s you might be interested in. 
Loading the detailed maps may improve the ETA calculation slightly.

Problem Resolution
This section provides information on solving problems you may encounter while using the Map 
Loader program.

Internet Connection Problems

Internet Explorer on the Pocket PC can be used to verify that an Internet connection is present 
on the device. This connection can be established via a network card, a connection to a cell 
phone, a connection to a modem, or via ActiveSync.

The easiest connection to establish is with ActiveSync. The ActiveSync connection presumes you 
have an Internet connection on the PC itself and then passes this connection to the PDA. It 
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must be already connected before the PDA can use it. To connect via ActiveSync follow these 
steps:

1. On the Pocket PC check Settings > Connections > Connections > Advanced > 
Network Card.

2. In the top menu, ensure that the setting is 'Work'.

3. On the PC be sure that the WayPointtm PDA shows “connected” on the ActiveSync 
display.

4. In ActiveSync under Tools > Options > Rules ensure the Pass through setting is also 
set to 'Work'. The setting in active sync and the PDA must agree.

Map Activation Problems

If the unit does not permit you to install a map set that you own you have a map activation 
problem. To fix this problem you need to tap Map Tools and then Repair Activation key.

If you have an Internet connection this will automatically fix the activation key based on the 
Mobile Crossing database information. Otherwise you will see the Device ID page as shown at 
the left below. You can use the data on this page via phone or the Mobile Crossing web site to 
retrieve your Map Activation key. Tap Next to enter the activation key

         

Flash Disk repair

If you are attempting to load a region on your Flash Disk area and there isn’t room you may need 
to erase the current maps that are on the card. Generally this can be done simply by removing the 
current region from the area but if there are still maps remaining you can use the Map Tools > 
Erase Flash Disk command to clean up the map directory on your Flash Disk. This will 
remove the entire contents of your map directory.

Map Loader will not be able to remove maps if you have them open in the WayPoint software. 
Be sure that you exit the WayPoint program using Tools > Exit.
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If a region still won’t fit it means you have placed too much additional data on the Flash Disk. 
You will need to use the File Explorer to remove enough data so that your maps will fit.

Recovering Missing Maps

If the download failed to load all of the maps needed for a region you can revisit the Build Map 
screen to recover the missing files. The missing map files can only be recovered by downloading 
them from the web site.

If you need to recover files that are on your Map Loader prepared card you should remove the 
effected region and reload it. When you are offered the option to repair the region select ignore 
errors and then use the manual recovery method of removing the region and then reloading it.

To recover the missing maps using the you will need to select the destination for the maps from 
the main menu. You will see the screen shown below.

       

At this point you have several choices as shown in the figure. You can view missing files to see 
if they are ones you still need. If they are and you have an Internet connection you can tap the 
Download now button to retrieve them. You may also choose to Try it later which will 
postpone your decision or choose Ignore Error if you have decided not to fix the error.

If you choose to ignore the error and decide you need the files later you will need to re-install the 
full region.

File List lost

If you receive a message that your file list has been lost or corrupted you must fix this condition 
before proceeding. If you have an online connection you can download a new one from our web 
site by tapping the Download to repair button. Otherwise you will need to install the files 
manually.

If you have a Map Loader Card containing the source map files you can insert this card to fix this 
problem. Please refer to “Making your own Map Loader card” on page 83 for information on 
building this card if you don’t want to purchase a card.
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Map too Large to fit

This error is caused by trying to load too large a region into the space remaining. The solution is 
to remove some files. The Map Loader can be used to remove other regions to make room for 
the new region. The file explorer program can be used to remove other files as needed to make 
space. Tap the ok button to refresh the screen size measurement if needed.

A special case is that this error can be because the Longhaul maps are loaded and a very large 
region is being installed. Due to updated maps from NavTeq a few regions have grown so large 
as to prevent the Longhauls from co-existing in the Flash Disk area. Mobile Crossing has decided 
that supplying the larger maps is preferable to reducing the region area in most cases although 
some region definitions may be changed if needed. If you need or want some Longhaul maps in 
these large regions the following procedure can be used:

1. Load the Longhaul maps using the Map Loader prior to selecting the region.

2. Check the region you want to load to determine how much additional space you 
need.

3. Use the File Explorer program to traverse to the map directory and look at the maps. 
If you do not see maps tap and hold on the screen and select View All Files.

4. Delete maps you do not need. (If you can’t tell the name of the map use the rename 
command to display the full map name. They are in alphabetical order.)

5. You can use Settings > System > Memory > Storage Card to check the amount of 
free memory. It is a good idea to leave 1 or 2 Meg free for future use.

6. Repeat steps 4 and 5 until the desired amount of memory is reached and then return 
to the map loader.

Other Map Loader Errors

The screen error message will provide instructions on recovering from the error.

If you use Settings > System > Memory > Running Programs to stop the Map Loader you 
may find more than one entry in the list. Be sure and stop all copies. Do not attempt to activate 
Map Loader from this menu.

Do not run other programs while Map Loader is running. If you have to be sure and quit out of 
them to return to Map Loader. Switching directly to Map Loader may causes sequencing errors 
between screens.

Be sure that the WayPointtm software is not running when working with maps. If the WayPoint 
program has the maps open you will not be able to erase them.



91

B
lu

et
oo

th
 O

pe
ra

tio
n

Chapter

9
Bluetooth Operation
Bluetooth GPS is a feature of the WayPointtm 200 product. Bluetooth wireless technology 
consists of a CF hardware card and Bluetooth management software with a Bluetooth Driver. 
The intent of the Bluetooth module is to permit the use of the Bluetooth GPS receiver but it can 
also be used for many other tasks.

Bluetooth Hardware
The Bluetooth hardware is a CompactFlash card that is inserted in 
the slot at the top of the unit. It may automatically turn on when it 
is inserted. It can be turned on or off from the Bluetooth menu. 
Use the Bluetooth  icon on the command bar at the bottom of 
the Today screen to manage the Bluetooth connections. Expect 
some loss of battery life when the Bluetooth module is in use. 

There will be small x in the lower corner of the Bluetooth icon if 
the card is not present.

A lamp on the module blinks to remind you that it is in use and is 
working. When it is receiving data is may turn solid on. The 
Bluetooth antenna extends slightly above the PDA case and 

contains this lamp. 

If the Bluetooth module does not turn on automatically use the Bluetooth menu to Turn the 
Radio on (or off). 

The settings in the Menu can be used to reach Bluetooth connections if they have been 
previously configured. In the case of the GPS connection it can configure itself automatically (see 
“Enabling the Bluetooth Driver” on page 93.) This is also the place where the Bluetooth radio is 
turned on or off and where the unit can be changed from hidden to discoverable. Be sure that it 
is on before proceeding. To configure the devices and connections use the Bluetooth Manager. 
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For the serial port connection needed for GPS use many of these 
settings do not make any

 
This is a class II 
Bluetooth radio with 
a maximum range of 
up to 32 feet (10 
meters) and a data 
rate up to 721 Kbps. 
It supports up to 7 
devices. It is compli-
ant with the Blue-
tooth V1.1 standard. 
The typical power 
consumption is 
40mA but can reach 
90mA peak.

 difference, but may be changed for increased 
security or to restrict what can be done with the connection. Once a 
GPS device is set up as the default for Bluetooth serial connections the 
Bluetooth software will automatically connect to that device when the 
mapping application requests it.

Automatic Operation
There is a special feature that provides automatic operation of the 
Bluetooth for GPS operation. The Bluetooth GPS receiver must be 
turned on for these features to work This capability includes:

• Automatic configuration and connection to a WayPointtm 
Bluetooth GPS. Tap the Start GPS to automatically search and 
pair with the GPS device. Once the connection is made the 
WayPoint application will automatically be started. 

• Automatic reconnection of the GPS if you power off the unit. This is specific to the 
default GPS device which will cause the Bluetooth to reconnect to this unit when 
powered on. 

• It will also cause the GPS to be found and connected automatically if a Bluetooth GPS 
is requested from the WayPoint program or any other GPS enabled software.

Bluetooth Manager
The Bluetooth manager establishes the connections with supported devices. When you start the 
Bluetooth Manager you will see the ShortCuts Window. In the figure below left a serial port 
Bluetooth device (In this case a GPS) is shown. The first time you enter the Manager this screen 
will be empty. To make a connection to the GPS as shown perform the following steps.
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1. Tap the hand shown on the command bar to bring up the Devices Nearby window 
shown on the previous page in the middle.

2. Generally this will kick off the search automatically. You can also tap the refresh icon to 
look for devices nearby. The screen shows that a GPS has been found.

3. Tap twice quickly on the icon to discover the services it provides.

4. Depending on the security settings it may ask you for a passkey. It is 2003 for this device. 
(Security level is controlled on Tool > Configuration) 

5. The window shown on the previous page at the right will appear.

6. Only the Serial Port service will appear for this a GPS device (on the left near the bottom 
as shown by the arrow). Tap it to connect and create a short cut.

7. You are now back to the screen you started with. A connection has been made to the 
Bluetooth GPS unit.

8. If this is the first serial device it will also be set as the default device. If you have multiple 
serial devices you can choose the default one from a menu.

9. Tap the  icon to leave the Manager or just press the WayPointtm  button to 
bring up the WayPoint application. It can use the Bluetooth GPS connection that was 
just created.

This is the minimum needed to set up the Bluetooth GPS but will only need to be done the first 
time. For more security you can set a bond between the devices by setting the security to “high 
security” on the Tool > Configuration > Options menu. A high security will require you to 
enter the security code. It is 2003 to make the connection. The devices will then be paired. It will 
remain paired unless you delete the pairing. Only one device at a time can use the serial 
connection. Once it is established, the GPS will be locked to your unit as if there was a wire 
running between them.

The WayPoint navigation tool will be able to access the Bluetooth GPS on COM 8. While the 
Bluetooth CF card does not use as much current as a direct connection of a GPS would, it still 
uses some power. It should be turned off when not needed.

Enabling the Bluetooth Driver
Normally the Bluetooth driver will always be running even if the Bluetooth hardware card is 
removed. If the Bluetooth icon is missing from the bottom of the Today screen it means the 
driver are not running. Use the start menu > programs and start the driver by tapping the 
Bluetooth icon named BlueSoleil. If the driver is already running tapping this icon will do 
nothing. A copy of this icon should be in the startup folder (\Windows\Startup) to automatically 
start the Bluetooth driver after a software reset.
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Other Uses
While the main intent of the Bluetooth module is to support the Bluetooth GPS unit, it can also 
support other activities and tasks. For example it can work with the contact list to send a contact 
via Bluetooth to another device or it can use the contact entry to dial a Bluetooth phone. It 
supports:

Service Definition
General Access (GAP)
Service Discovery (SDAP) Manages device discovery process

 ActiveSync 
Provide wireless ActiveSync capability.

 Serial Port (SPP)
Used by GPS - General Serial Port support

 Dial-Up network (DUN)
Used by a wireless modem. GPRS cell phones are 
supported.

 LAN Access (LAP)
Used by wireless access points to provide network 
connection

 Personal Area Network 
(PAN)

Provides a local network of up to 7 devices

 File Transfer (FTP)
Provides ability to transfer files between wireless devices

 Object Push (OPP)
Sends business cards

 Fax (FAX)
Used to support a wireless fax machine

 headset
Used to support a wireless head set for cell phones

 Audio Gateway
Similar to headset but no ring support

 Cordless Phone Gateway
Used to support a cordless phone

Check the Official Bluetooth website http://www.bluetooth.org for more information on these 
features or read the vendor documentation on Bluetooth that is available on the CD-ROM as a 
pdf file.

The PAN service can support a local network of up to 7 units. If one of the units on this local 
network is a Internet Access Point the full Internet can be browsed directly from the WayPointtm 
PDA. Thus a WayPoint unit could use the PAN network and a GPS serial connection to provide 
simultaneous access to the GPS device and an internet connection. This would permit Traffic 
Watch, for example, to be collecting live data while the WayPoint program is tracking your 
current location.
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The DUN service can be used with GPRS phones to support internet connections as well. This 
would also permit live Traffic Watch or Weather Underground capability.

Note that the Headset, Audio Gateway, and Cordless Phone Gateway are not implemented on 
the WayPointtm unit due to hardware limitations.

Screen Descriptions
The screens available for Bluetooth operation are generally 
available in the Bluetooth manager. The ACT menu on the 
command bar duplicates the screen access from the icons. In 
addition the status screen can be accessed from the today 
Bluetooth menu. The Radio on/off toggle and the Bluetooth 
Manager have already been described. The additional features are 
available on this menu include:

• 3 shorts cuts that permit direct access for previously setup 
features in the Manager. These are:

o Start GPS - This starts the default GPS device. It 
is intended to start the WayPoint GPS for use in 
the WayPoint application.

o Dial-up Internet - starts the default DUN connection

o Personal Network Access - starts the 
 default PAN connection.

• The Status screen shows the active connections. It is 
shown on the left. A disconnect can be performed from this 
screen.

• Discoverable is a toggle that permits the unit to be found 
by other Bluetooth devices.

• Exit - quits the Bluetooth application.

The SPP service shown on the Status screen is the address 
for incoming Serial Connections. The Bluetooth GPS is an 
outgoing connection as shown in the figure. The SPP service 
COM port is generally one higher than the Incoming Port 
however the hardware may choose whatever it wishes. To 

know which COM post address the GPS is really connected to the Shortcut properties can be 
used to verify the address.

The Screens in the Bluetooth Manager are shown below:
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After tapping Property text in the above middle screen shows the SPP connection is on COM 8.

The Options screen is reached Tool > Configuration in the Bluetooth Manager. It is shown on 
the above right.

• The Address is the internet address for a pan connection. 

• The name is the one used to identify the WayPointtm PDA in Bluetooth connections.

• The security can be set to high security to require paired devices. If not checked then no 
pairing will be required. 

• A fixed password for this unit can be assigned if desired. Otherwise you may be 
prompted for a Passkey. 

• The tabs show the connection options settings for various Protocols supported by this 
unit including the business card transfer (OPP).

Bluetooth GPS Receiver
The Bluetooth GPS receiver is the prime use for the Bluetooth module in the WayPoint PDA. 
The unit runs 8 hours on its own internal battery is fully charged when the lamp goes out. A few 
tips include:

• Do not exceed 5 V input. 

• If left unused, a fully charged battery will discharge itself over time. 

• Do not cover the antenna area shown in the figure on the next page. It is used for GPS 
reception and for Bluetooth operation. 
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• If you decide to pair the GPS and the Bluetooth module the passkey is 2003.

• The Bluetooth lamp will flash at a one second rate when you are connected and much 
slower while awaiting a connection.

• If the car power is removed when the ignition key is turned off, the unit will revert to 
battery power. Be sure and turn it off if you intend to leave the car for a long period.

Internal Antenna

External Antenna

Battery Status

External Power

Power On/Off

GPS Status

Bluetooth Status
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Chapter

10
Advanced Topics
This chapter is intended for reference on a wide variety of topics. It does not flow like the 
previous chapters did. Each section is standalone. The topics include:

• “GPS hardware topics” on page 99

o How a GPS works

o External Antennas

• “PDA Hardware Topics” on page 101

o Resetting your PDA

o Adding Hardware to your PDA

• “Advanced WayPoint Software features” on page 103

o Geocaching

o Using the Log file.

• “Extra Software” on page 104

o Installing Software

o Wisbar

o GPSInfo

• “More Information” on page 109
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GPS hardware topics
How a GPS works

The GPS receiver that you can hold in the palm of your hand is a highly complex and powerful 
device. You don't need to understand it fully in order to use it but some understanding can be 
helpful in getting the most from a GPS. 

First of all it is a radio wave receiver similar in some ways to a standard FM radio. It only receives 
signals but unlike a standard radio these signals come from satellites moving rapidly overhead. 
The receiver uses these satellite signals to compute a position on the earth. You need not worry 
that the satellites know where you are. They do not, only the receiver itself figures this out. How 
it does this is the subject of the next few paragraphs.

Unlike the standard FM radio which only receives one station at a time the GPS receives several 
signals simultaneously. As a matter of fact it needs at least three satellite signals to compute its 
position and to compute a full solution including altitude it needs four. Once it has computed the 
position it is said to have a fix or lock on the satellites and will then dynamically update the 
position once a second as you travel. 

Unlike the FM radio, a GPS receiver needs to have a fairly clear view of the sky in order to 
receive these signals. Signal reception is effectively blocked by water (however, not rain because 
the space between the rain drops), the human body, the metal roof on your car, a building, and 
many other things. The good news is that there are usually a lot more that 3 satellites overhead 
(sometimes as many as twelve) so if some are blocked others may be available. And just like the 
fact that you can see through some objects such as a window there are some objects that do not 
block signals for the GPS.

C O M P U T I N G  A  F I X

The GPS uses mathematical formulas based on the distance to the satellites and the position of 
the satellites to compute your location very much like a ship captain might take sightings on land 
objects or stars to compute the ship's position at sea. 

Because these computations are based on the current positions of the satellites the unit must 
download the position data from the satellites themselves. This takes about 30 seconds to receive 
but if it misses some of the data it could take longer. 

After the download is complete the computation can start. The computed position accuracy 
depends on what satellites the GPS can view, where they happen to be, and the ability of the 
receiver itself, but generally a consumer GPS receiver with a good sky view can compute a 
position that is accurate to about 30 feet. This is usually good enough to find your house or even 
your car but probably not good enough to settle a property line dispute.
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R E C E P T I O N  S T R E N G T H

Most GPS receivers or the programs that work with them provide a method for you to 
determine how good the current reception is. This is similar to the idea of determining the 
strength of the signal to a cell phone, but you need to know the strength of the reception of 
several satellite signals instead of just one. 

The WayPointtm display shows you where they are in the sky relative to your current position and 
how strong the signal reception is. If you notice that it is having trouble getting enough signals 
you might be able to help by moving a few feet or turning around so that the signal is not 
blocked. The top of the display is north.

By the way, once a GPS receiver has achieved its fix it is much better at maintaining it under 
adverse conditions than it was in getting the fix in the first place. It will dynamically add and drop 
satellites used in the solution as needed while you travel.

Most of the time you will never need to worry about any of this. You will just turn the unit on 
and it will find the satellites and compute the position solution in about a minute or even less and 
everything will be ok. You can just begin using it. However, if there are problems it can be helpful 
to know what can be done to resolve them.

External Antennas

Both of the WayPoint GPS models support external antennas as an optional accessory. You are 
not likely to need one unless you have one of those cars with the special coating on the 
windshield to block the sun’s heat. Unfortunately, this coating also blocks GPS signals. If you 
need a remote antenna, be careful with the cable. It plugs into the GPS with a click and you must 
hold onto the antenna connector by the plug to pull it out. Pulling it out with the cable will 
eventually break the cable.

There are situations where an external antenna can help even though it is not needed.

• For versatile installation options such as mounting the PDA or GPS receiver in a 
location that is not optimum for GPS reception.

• For security the Bluetooth receiver could be placed in the glove box with the antenna 
located in an external location.

• Using WAAS – For the ultimate in accuracy some folks want to use WAAS which is an 
augmentation system that can improve location accuracy. The signal for WAAS comes 
from a single satellite that is located in the southern sky. Having an external roof 
mounted antenna will improve the chances of receiving this signal.

• Traveling in the mountains or deep woods. The addition of an external antenna on the 
roof will permit the reception of one to two more satellites that would normally be 
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blocked by the metal roof. In poor reception conditions this can make a difference in 
whether there are enough signals to produce a fix or not.

PDA Hardware Topics
Resetting Your WayPoint PDA

You will need to reset your WayPointtm PDA after restoring data from files backed up on your 
PC, or in the event of the operating system freezing up. Resetting provides a similar function to 
rebooting your PC, restarting the operating system. All saved files and settings are preserved, 
although any unsaved files will be lost.

To reset your WayPoint PDA, remove it from the USB cradle and make sure that the CF 
Expansion slot does not contain any I/O devices that might start up during the reset. Locate the 
software reset button on the back of the device. You may wish to unscrew the top end of the 
stylus and use it to push the button.

Restoring the Factory Defaults

If your WayPoint PDA fails to respond after being reset, you might have to restore the factory 
defaults. This is the software state that the device was in when you first started using it; the 
operating system and preloaded software stored in Flash ROM are preserved, but the programs, 
files and settings stored in RAM are erased. You latest backup can be used to restore the RAM 
contents.

To return your WayPoint PDA to its factory state, unscrew the top of the stylus and use it to 
slide the hardware master power switch from on to off to turn the device off, and then back to 
the on position again. 

Remember that the main battery must be removed to see the switch. Alternatively, you can 
simply allow the batteries to run down completely. Once you have restored the factory defaults, 
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you will need to re-install your programs, reload backed up files and adjust the settings to suit 
your personal preferences.

Master Power Switch

Slide the Master Power Switch from on to off and then back to on again. The figure shows the 
back of the stylus being used to change the switch.

Adding Hardware to your WayPoint PDA

The Mobile Crossingtm WayPointtm PDA is a very versatile unit. It is possible to add external 
devices to the unit to supplement the hardware you received. Extra devices can be plugged into 
the serial connector on the bottom of the unit, hooked via the IrDA (Infrared) port, or plugged 
into the CompactFlash slot. The following I/O slots are available:

• COM 1: Serial Port. This is available as separate pins on the USB / Power connector on 
the bottom of the unit. Baud rates up to 115 Kbps can be supported. The pin-out of the 
connector is the same as an iPAQ. This can support modems, cell phones, network 
hardware, and even other GPS devices.

• COM 2: reserved

• COM 3: CF Card slot. This slot can support I/O devices and memory devices when the 
WayPoint GPS solution is not plugged into the slot. Power is supplied to the device 
plugged into this slot. Do not use devices that require more than 500 mA. There are a 
wide range of I/O devices that will work in this slot but Mobile Crossing cannot 
guarantee that any particular device will work.

• COM 4: IrDA. This is the port used for beaming files between units.
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• COM 5: USB. This is a USB slave port. It can only be used to communicate with master 
USB devices such as a PC. ActiveSync uses this port.

• COM 6: IrCom. The infrared serial port with similar capabilities as the serial port.

• COM 7, 8, 9 are potentially used by Bluetooth plugged into the CF card slot.

The WayPointtm 200 includes a Bluetooth card in the CF slot. This card can support up to 7 
devices simultaneously in a pico net. The list of devices that have Bluetooth support is growing 
daily.

The CF card slot and the SD card slot can support memory devices from a variety of 
manufactures. Note there is a wide variation of performance and current requirements on these 
devices. Generally the faster devices will have more impact on the battery life. The SD slot does 
not support I/O devices but does support MMC cards. MMC cards are typically about 3X 
slower than slow SD memory cards on the WayPoint hardware.

Advanced WayPoint Software features
Geocaching

Geocaching is a hobby where some people hide a cache of stuff (none of it particularly valuable) 
and then identify the location with GPS coordinates. Other folks set off to find these hidden 
treasures and leave their name in a log book. It is actually more fun that it sounds and it can be 
done with the unit you have. Here is how:

1. With the GPS off use the Tools > Find > Latitude Longitude

2. Enter the values for the Geocache site and add it as a landmark.

3. Route to the Landmark you created to drive as close as your car can get.

4. Use the air navigation panel if you need the map or the GPS status screen to walk to the 
geocache destination. Good Luck!

Using the Log file

The WayPoint software includes the ability to create a log file that will record a trip. There are 
many things that can be done with the log file.

• The log file can be saved in a file.

• The logging (GPS trail) can be displayed live on the screen so that you can see a visual 
record of where you drove while you are driving. This can allow you to retrace your 
steps visually if you need to.
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• The log file can be displayed on the map later to have a visual indication of the entire 
journey.

• Each of the points on the log can be tapped to see the actual speed and other data about 
that point, or you can view the details in a list.

• You can display a summary of the trip.

• The log file can be played back from any point to simulate the travel.

• If roadlock is set the log file entries will try and lock to the road.

Logging is under control of the GPS setup but the viewing of the GPS trail itself is controlled by 
the Map Settings. To playback a log file you must select one of the summary files first or a point 
in the detail list. Summary files and details lists are created for each trip you take. You can switch 
between them with the View menu.

Extra Software
Mobile Crossing has included some extra software on the documentation CD-ROM that will 
prove useful to our customers. These programs are described below. Thousands of other 
programs are available for Pocket PC devices. Those specifically targeted to Pocket PC 2002 or 
later will generally work ok on the WayPointtm PDA. These should be marked for an ARM or X-
Scale processor. Mobile Crossing cannot guarantee whether any given software product will 
work, nor are they responsible if a particular software product interferes with proper operation of 
the unit.

Installing Programs

There are three methods of installing programs on your WayPoint PDA.

1. A special setup program on a pc can be used. This is the usual way to install software and 
requires a pc running ActiveSync. The program sets up the data and pushes it to the 
PDA. It is not required that you have an account on the pc. Using a Guest account will 
do, so if you don’t have a pc perhaps you can borrow one for a few minutes.

2. The second method is to just copy the Pocket PC executable program itself to the PDA. 
This can be down in any of the methods used to copy a cab file. The program can be 
stored anywhere and executed by using file explorer to find the file and tap on it. 

This will only work for fairly simple programs that do not have extra files that are 
needed for execution. If the file is moved to the windows\Start Menu\Programs 
directory it will show up on the start menu. It is also possible to keep the program in 
another location and use file explorer to create a short cut from the Programs directory 
to the program itself.
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3. The third method is to use a cabinet file. These files are specially prepared files for the 
pocket pc. They have a .cab extension. The file can be downloaded to the unit directly 
from the web, moved to the unit from a pc, available on a memory card that is plugged 
into the unit, or even beamed from another unit. 

File explorer can be used to install a cab file just by clicking on it. The cab file will always 
install the program to a predefined location and the cab file itself will be removed at the 
end of the installation. 

There is a third party program available, called cabinstall, which permits more control over this 
process including keeping the cab file and installing to a memory card or location of your choice. 
The cab install program does not need to be installed. You just copy it to the WayPointtm unit 
and place it anywhere you wish. Use file explorer to locate the program and tap it to start it. 

If you check the “Associate CabInst” setting then you can just tap 
a cab file and the program will automatically be started. Otherwise 
you can tap the .CAB button to bring of a file browser to pick the 
cab file you wish. 

To traverse the file system double tap on the directory names. 
You can decide to keep or delete the cab file after installation and 
you can decide whether to install in the default location or one of 
your own choosing. 

Some files will automatically go in a special place even if you 
choose a different one. This is normal.

This program was written by a Russian programmer and he has 
offered it for free. His web site is http://www.geocities.com/s_k_s_k_s_kru/.

Wisbar

Wisbar from Pelmar is a tool that permits a user to customize the 
look of the Title bar on the WayPoint PDA. It also permits the 
user to manage the running tasks easily. Wisbar can switch among 
tasks and can kill ones you are no longer using. Wisbar also helps 
with monitoring the battery level by placing an icon on the Title 
bar. The battery icon can be tapped to look at the actual gauge 
instead of chasing it down in the systems menu.

Wisbar is very customizable. One view is shown at the left. One 
of the major reasons to use Wisbar is the additional menu. This 
menu can be reached by tapping on the clock time on the Title 
bar. 
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The menu provides several program management services such as: 

•  showing all running programs 

• allows you to tap on any of them to switch between the 
applications. 

• The X on the right can be used to actually stop the 
program thus freeing up the memory resources used by 
the program. 

The settings entry shown on the menu permits you to customize 
how Wisbar works. Also shown in the image are the memory and 
battery usage icons on the title bar. The memory program space 
is about ¾ full while the battery is shown at full charge. Tapping 
this will bring up the battery gauge.

Wisbar must be started manually the first time but if it is running it will continue to run even if 
the PDA has been restarted with a software reset.

Wisbar is included with the kind permission of macpel at http://www.macpel.com/html/
pocket_pc.htm

GPSInfo

GPSInfo from Globalsat Technology Corporation is included to provide a troubleshooting tool 
for any GPS problems that might be encountered. It can be used to 

• reset the GPS device

• provides analysis data about a fix. 

• enable WAAS on the GPS devices included with your WayPointtm PDA. 

It does not report whether WAAS is in use. WAAS is an augmentation system that can provide 
increased accuracy in some situations. It is generally not needed for road navigation, particular 
when road lock is in use. WAAS takes one of the GPS satellite positions from the receiver so you 
cannot use 12 satellites when WAAS is in use. The implementation on WayPoint GPS devices 
supports corrections for signal errors but does not support WAAS ranging where the WAAS 
satellite could be used to substitute for the 12th satellite.  EGNOS is the European version of 
WAAS.

http://www.macpel.com/html/pocket_pc.htm
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S E T U P

The opening screen for GPS Info is the place where the 
connection to the GPS unit is performed. Only one program can 
be attached to a GPS unit at any one time. If a connection cannot 
be established check and ensure that the WayPointtm software is 
not running or has closed access to the GPS. The setup page 
permits some control over the GPS itself. The commands include:

• The Cold Start button will reset the GPS and require a cold 
start. This could take some time so only do this when you have a 
clear sky view and are willing to wait until a GPS fix is obtained.

• VTG checked with add this message to the NMEA strings of 
data. You should not do this unless a program specifically needs it.

• Power Save and save significant amounts of battery power but at a cost in performance. 
Use this at your own discretion, but it is not recommend under difficult reception 
conditions.

The WAAS switch can be used to toggle the differential correction capability on or off. Using 
WAAS ties up one of the receiver channels and is not needed for use with road navigation 
software.

The bottom of the screen shows NMEA messages as they appear. Its primary purpose is to 
demonstrate that the GPS is actively send data and the PDA can receive it.

G P S  I N F O

Tapping the GPS Info tab brings up the information display. This screen shows a map of the 
current satellite positions with the current reception signal strength for each satellite shown 
below the map. The text data about the fix surrounds the map. It is primarily about the GPS 
PVT solution. 

• All GPS receivers compute PVT, Position, Velocity, and Time as the full GPS solution. 

• At the top is the GPS computed UTC date, followed with the UTC time. 

• GPS solutions are usually computed with respect to Universal Time Coordinated (UTC) 
which used to be called GMT (Greenwich Mean Time). 

• The time is computed at longitude 0 which passes through England. California is 8 
hours later than UTC (7 hours during DST).
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The other information shown includes:

• the Velocity (Speed and Direction) 

• the Position (Latitude and Longitude) except that altitude is 
missing.

The rest of the text is concerned with the quality of the fix itself. 
The Status reports that the GPS has a 3D solution which means it 
is computing a solution in all three axes which requires at least 4 
satellites. 

In addition it is showing a HDOP, Horizontal Dilution of 
Position and a PDOP (Point DOP). Dilution of Position is a 

unitless number that represents how good the solution is based on the current satellite positions. 
For horizontal DOP any number less than 2.0 is very good. 

PDOP provides a number that includes both horizontal and vertical accuracy and 3.0 as shown 
above is a good number for this. This computation is based strictly on the arrangement of 
satellites as shown on the screen. Numbers above 6.0 would indicate a poor arrangement that 
might not lead to very accurate results.

The bar chart at the bottom of the screen shows the S/N ratio of each satellite (signal strength) 
and the blue bar indicates the satellites that are contributing to the current solution. The numbers 
at the bottom of the bar are the same numbers as the one on the map so that the two charts can 
be tied together. The receiver is getting a signal from satellite 6 but does not have the data yet to 
use it as part of the solution. 

By the way, the map of the earth shown on the upper chart is bogus since the satellite view is 
looking up, not down with the center of the circle representing the current location and North at 
the top. The map itself is only a graphic and provides only misinformation but looks nice.

TrafficWatch and Weather Underground

There is a copy of TrafficWatch and Weather from Weather Underground already built in to 
your WayPointtm PDA. These are trial executables that can be used to explore this subscription 
service. You will need to subscribe to continue to use these applications. WayPoint 200 owners 
have a free year’s subscription to this service.

The data is provided via an internet connection from a Mobile Crossing server. If you are hooked 
to a computer via ActiveSync you can take advantage of the computer’s internet link to provide 
this data. It is also possible to use a direct internet connection via a LAN card or even a cell 
phone providing real time data while traveling. After the data has been collected it can be 
displayed even if you are off line.

• TrafficWatch provides live traffic data for selected cities. This includes freeway speed 
information and data about potential bottle necks.
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• The Weather Underground program provides real time weather data.

The programs can be executed from the Start menu or via the 
WayPointtm Navigation program. If you tap and hold the 
WayPoint  button for a second or so it will bring up the 
QuickLaunch program. QuickLaunch can also be started from the 
Start menu.

Tap the appropriate icon to launch the program.

There is room for more programs that can be launched from this 
screen. The WayPoint icon returns to the WayPoint program or 
you can just press the WayPoint button.

TrafficWatch and Weather Underground have their own manuals. 
They are available from the Mobile Crossing web site.

It is possible to customize the applications that are launched from this Quick Launch by editing 
the xml file that controls this operation. The file would need to be moved to a PC to perform this 
edit. For more information on customization please check the programing interface manual.

 More Information
There is more information available on the CD-ROM that accompanies this product. The extra 
documentation is in PDF form and requires a copy of Acrobat reader to read it. A copy of 
Acrobat reader is freely available for many platforms including a Windows PC, and the WayPoint 
PDA using the Pocket PC reader. 

There are copies of all the supplied manuals and extra documentation on using the Pocket PC 
operating system, the Bluetooth operation, and the GPS devices included with the WayPoint 
system. Other documents may be included as well.

These documents can be found by using the automatic Setup command or browse in the OEM 
directory on the CD-ROM. A readme.htm file in the OEM directory permits your html browser 
to access this data if you are not on a PC.
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Chapter

11
Troubleshooting
Should you have trouble with your unit the following tables may be able to help. Note that 
solutions for problems using the Map Loader are found at “Problem Resolution” on page 87. If 
you are unable to resolve the problem call 1-800-605-8198 for help.

PDA Problems
Problem Possible Cause/Solution
My unit won’t turn on. 1. Make sure the master power switch under the battery is 

on.

2. Make sure the battery is in place and the cover is close 
tight.

3. Make sure the battery is right side up. the connectors in 
the upper right corner of the battery must contact the 
connections on the PDA.

4. Make sure the battery is charged. Plug the unit into AC.
My clock reset to 12:00, 1st 
January 2004

This is caused by a complete power failure / hardware 
reset.The GPS will automatically set the correct time. 

I can’t tap the right place on 
the screen with my stylus?

You probably need to recalibrate your screen. Use Settings > 
System > Screen.

The screen is too bright / 
dim.

The screen backlight brightness is adjustable. Settings > 
System > Backlight

The power light is flashing 
from red to green to off.

This indicates a really low battery condition. Recharge the unit 
for several hours. If this persists you may need a new battery.

Poor quality sound when 
playing music through the 
internal speaker.

The playback is distorted when the volume is set too high. 
The internal speaker is not designed for high fidelity, use 
headphones.
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The Keyboard is too hard to 
use.

1. Try selecting the larger keyboard. Tap Settings > Input.

2. Check third party software or hardware solutions. 

3. Learn a different input technique. There are 4 to choose 
from.

My recording quality is not 
very good.

The default sampling frequency has been set at 22KHz. This 
bandwidth can be altered to improve quality, but doing this 
will use more memory. Tap Settings > Input > Options. 
Select a higher frequency from the voice recording drop-
down menu

My better quality recording 
doesn’t work in the calendar 
or tasks.

To conserve memory, the calendar and tasks applications can 
only support a sampling frequency of up to 8KHz

My unit turns on whenever I 
insert or remove a CF slot 
device.

This is a requirement for Pocket PC PDA devices and is 
normal.

Active Sync is invoked 
whenever I plug a serial cable 
into the unit.

Make sure that you disable the “synchronization when 
cradled” option in the ActiveSync Tools menu.

I can’t transfer data to or 
receive data from a Palm 
device.

Peacemaker is a cross platform, infrared transfer utility for 
handheld devices. More information can be found at  
http://www.conduits.com/ce/peacemaker

My WayPointtm unit will not 
turn on when disconnected 
from power.

The battery is probably not charged enough. Try charging 
longer.

My battery runs down too 
fast.

1. Running CPU intensive tasks.

2. Backlight set too high.

3. Device plugged into CF slot taking power.

4. Older battery may be getting weak and needs to be 
replaced.

My Unit runs too slow. 1. Too many applications are running – stop a few of 
them. Settings > System > Memory

2. Low on memory – Either too many applications 
running or too many are installed in RAM. Settings > 
System > Remove Programs.

New Driver just installed is 
not recognized.

Try a software reset.

Problem Possible Cause/Solution

http://www.conduits.com/ce/peacemaker


112

PC Connection Problems
Problem Possible Cause/Solution
I can’t connect to a LAN network 1. Your Ethernet/LAN card is incompatible with 

your WayPoint PDA.

2. The correct drivers for your Ethernet/LAN 
card are not installed.

3. You are trying to connect to an incompatible 
server. It must be a DHCP server.

4. The data in the configuration is incorrect. Check 
settings and login data.

5. The server is busy. Try again later.
My WayPoint PDA is not 
recognized by ActiveSync.

The WayPoint PDA is a new hardware unit and your 
driver may not include support for it. Be sure and install 
the driver from the CDROM that came with your unit.

I can’t ActiveSync via IR. Make sure there is less than 30cm between devices and 
that the angle is no more than 30°.

Bluetooth Problems

My Windows program won’t 
work on my WayPointtm 
PDA

While a Pocket PC looks like windows it requires special 
Pocket PC programs. Windows programs will not work.

Problem Possible Cause/Solution
I can’t connect to a Bluetooth 
Device.

1. The Bluetooth unit is not turned on. Check the 
Bluetooth icon at the bottom of the Today 
screen and make sure the unit is on. The lamp 
on the Bluetooth module should be blinking.

2. The range is about 32 feet under the best 
conditions and less if there are obstructions. 
Move the devices closer together.

The Bluetooth icon is missing 
from the Today screen.

Restart the Bluetooth driver by tapping the BlueSoleil 
icon in the Programs folder.

Problem Possible Cause/Solution



113

Tr
ou

bl
es

ho
ot

in
g

Vehicle Mount and power
Problem Possible Cause/Solution
There is no power to the 
WayPointtm mount

1. Make sure that there is power on the outlet. 
Many cars remove power when the ignition is 
turned off.

2. Check the fuse. It is in the tip of the power 
connector.

No sound from the speaker. 1. Try twisting the connector at either end of the cable to 
ensure that it is making good contact.

2. Turn up the volume on the side of the vehicle mount.

3. Remove the cable to ensure that the audio is being 
produced by the PDA itself.

Sound is distorted. Reduce the volume in the PDA and turn it up on the 
vehicle mount to compensate.

Suction cup falls off the window. Moisten the cup before sticking it on the window. 
Check it frequently. It cannot be trusted to stick 
permanently. 

WayPoint navigation

Bluetooth device initialization fails. This usually means the Bluetooth hardware is not 
plugged in or has malfunctioned. Try removing and 
reinserting the module. If you are unable to start the 
device check with Mobile Crossing.

New Modem message appears 
when the module is plugged in.

This is a normal Microsoft message and can be 
dismissed.

Problem Possible Cause / Solution
Can’t route to a location in my 
database

Likely the local detailed map is not loaded.

Searches take too long The first time a search is required the full database must 
be loaded. If it is still too long after the first time then try 
removing unneeded maps.

GPS loses lock too much. Try a different mounting location. Add an external 
antenna.

On the CF card tilt the unit a little more. Even a few 
degrees of tilt will improve the GPS reception.

Problem Possible Cause/Solution
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Tips and Techniques
Here are a few tricks to make the WayPoint navigation software perform better.

• Turn on the City name display in map setup in the Pop-up Information box of the setup 
screen. This will let you tap anywhere on the screen and find out what city you are in. It 
can be frustrating to be able to see the roads and not know what city you’re in, yet 
displaying the city name all of the time can cause clutter on the screen.

• The GPS is more accurate than the maps in many areas. If the GPS seems to be 
jumping to the wrong road too much try turning off Lock to Road. It may be easier for 
you to determine the correct road visually that for the computer to do it.

• If you plan on using the same route again be sure and save it. This will save time since 
you won’t have to enter the locations again. A route can be reversed and then saved to 
find your way back easily. Do this before you even start to use it.

GPS takes too long to get a lock. 1. Let it get a lock before moving. Drive out from 
under trees or other obstructions that may be 
blocking the sky view and then stop.

2. If you have traveled a couple hundred miles 
since the last use then it may need initialization. 
Do step one and expect it to take 10 minutes or 
more to initialize.

Program can’t find the GPS Make sure the COM port is set to 3 for a CF GPS and 8 
or 9 for a Bluetooth GPS. Baud rate must be set to 4800.

The program can’t find my maps 
on an external card.

Under Tools > Choose Map select ALL FOLDERS.

Pressing the right button does not 
launch the WayPointtm software.

Select the WayPoint application on Settings > Button 
for Button #5.

GPS shows all satellites in the 
center in one row. Most or all 
show 0

1. The GPS unit was left on while inside and you 
didn’t have a fix.

2. You have moved 200 miles since the last time 
you used the GPS.

The solution to both of these problems is to take the 
unit outdoors with a good sky view and wait until it gets 
a lock. See “Using the Cursor Keys” on page 43

Problem Possible Cause / Solution
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• Consider using the Route Through feature to control the router and get exactly the 
route you want. It is also very useful for multiple stops if they are all on the way.

• If your trip spans a time zone use the Visiting choice on the clock settings to change the 
time zone used by the unit.

• For local routes use the most exhaustive routing option but for long routes you may 
want to reduce this value to improve routing time. Reducing the number of loaded 
maps will also reduce the routing time.

• If you are using your WayPointtm unit primarily as a GPS you can defeat the automatic 
Today screen switch from the Settings > Today menu. This will leave the navigation 
program on the screen even if you turn the unit off for more than 4 hours.
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Appendix

A
Appendix A - Technical Specifications
This chapter lists the specifications for the hardware included with the WayPointtm system.

WayPoint PDA Specifications
Operating system Microsoft Pocket PC 2003 Premium Edition

CPU Intel XScale PXA 260 400MHz

LCD Display
3.5” Transflective TFT Module with Touch Panel 
Using NVIDIA MQ1188 Video Controller 
Resolution: 320X240 (64K Color) 

System Memory

SDRAM: 64 MBytes On Board (41 Meg free after system buffers are 
allocated for increased performance)
Rom: 32 MBytes for OS
Flash Memory: 128 MBytes On Board (primarily for map storage)

Audio
Built-in Speaker & Microphone
AC97 Codec 
3.5 mm stereo headphone jack

Wireless
IrDA 115 Kbps 
Bluetooth Module Option (Uses CF slot)

Extension Interfaces

1. Compact Flash X1 (Type II)

2. Secure Digital / MMC X1

3. Client USB X1 via shared 22 pin connector

4. RS232 X1 (115 Kbps) via 22 pin connector 

5. DC IN +5V / 2A via 22 pin connector
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Note: The 22 pin USB / Serial Port / Power connector used on the WayPointtm 100 and 
WayPoint 200 is the same as the connector that is used on HP iPAQ models 3800 / 3900 / 5100 
/ 5400 / 5500 / 2200 series. The pin-out is the same thus cables made for these units will usually 
work with the WayPoint models. Different electrical characteristics may prevent some functions 
from working the same.

Operating Conditions
Temperature and Relative Humidity

Operation 0 - 40ºC, 10 - 90% RH

Non-operation -10 - 50ºC, 10 - 90% RH

Storage -25 - 65ºC, 10 - 90% RH

Function Keys

1. Power Button

2. Master Power Switch

3. Thumb Wheel (3 Way)

4. Software Reset Button 

5. Recording Switch

6. Application Buttons x4 

7. 4 Way Cursor Key Pad 

8. Battery remove & lock Switch

Battery
Back up Battery: 20 mA/1.2V Ni-MH 
Main Battery: 1300 mAH/3.7 V Lithium Ion Replaceable Smart 
Battery Pack

Power Adapter
Input: 90~260 VAC, 50~60 Hz 
Output: (Voltage: 5 VDC; Current: 3 A)

LED
Green / Red LED for charged indicator 
RED LED for O/S Alarm and Turn Assist 

Dimensions
135 (L) mm x 79 (W) x 16 (H) 
5.3” (L) x 3.1” (W) x 0.63” (H)
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Com port usage

Com1  Serial / Modem interface
Com2  Reserved
Com3  Used for serial / Modem interface in the CF slot.
Com4  IrDA
Com5  USB
Com6  IrCom
Com7  BT serial 1
Com8  BT serial 2
Com9  BT serial 3
Com0  CF network card

GPS Technical Specifications
The specifications are for all WayPointtm GPS units except as noted. (CF for CompactFlash GPS 
and BT for Bluetooth GPS)

Accuracy 15 meters 2D RMS 95% of the time 
< 5 meters 2D RMS 95% of the time when 
WAAS is being received.

Datum WGS 84
Hot Start 8 sec. Average
Warm Start 38 sec. Average
Cold Start 48 sec. Average CF; 80 sec. BT
Reacquisition 100 ms. Average
GPS output data GGA, GSA, GSV, RMC, VTG, GLL
Transfer Rate 4800,n, 8,1; any Baud rate will work for BT
Update Rate 1 Hz
Operating Temperature -10° - 70° C CF; -20° - 60° C BT
Storage Temperature -40° - 85° C
Power 90mA CF, 8 hours BT per charge.
External Antenna MMCX connector CF and BT
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Vehicle mount
These specifications apply to either vehicle mount.

Power Source 12 V to 24 V DC
Operating Temperature -10° - 60° C
Storage Temperature -20° - 80° C
Charging Temperature 0° - 45° C
Output Voltage 5V nominal, range 4.75 - 5.25 V
Power LED illuminates whenever power is received by 

the mount.
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B
Appendix B - Regulatory Notices
FCC Notice
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy, and if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception (which can be determined by turning the equipment 
off and on), the user is advised to take one or more of the following measures:

• Reorient or relocate the antenna of the unit receiving the interference.

• Increase the distance between the equipment and the receiver.

• Connect the equipment into an outlet on a circuit different from that to which to 
receiver is connected.

• Consult your dealer or an experienced radio/TV technician for help.

Modifications

The FCC requires the user to be notified that any changes or modifications made to this device 
that are not expressly approved by MOBILE CROSSING. Making modifications may void the 
reference authority to operate the equipment.

Cables

Connections to this device must be made with shielded cables with RFI/EMI connector hoods 
in order to maintain compliance with FCC Rules and Regulations.
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European Union Notice
Products bearing the CE marking comply with both the EMC Directive (89/336/EEC) and the 
Low Voltage Directive (73/23/EEC) issued by the Commission of the European Community 
and if this product has telecommunication functionality, the R&TTE directive (1995/5/EC). 
Compliance with these directives implies conformity to the following European Norms (in 
parentheses are the equivalent international standards and regulations):

• EN55022 (CISPR 22) - Electromagnetic Interference

• EN55024 (IEC61000-4-2, 3, 4, 5, 6, 8, 11) - Electromagnetic Immunity

• EN61000-3-3 (IE61000-3-3) - Power Line Flicker

• EN 60950 (IEC60950) - Product Safety

Safety Instructions
This product has been tested for conformance to international safety regulations. Like any 
electrical device, however, it should be used with care. To protect yourself from possible injury 
and to minimize the risk of damage to the product, it is important that you follow these safety 
instructions.

1. Do not attempt to service the product yourself. Refer servicing to qualified personnel.

2. Unplug the product from the wall outlet before cleaning. Use a damp cloth. Do not use 
liquid or aerosol cleaners.

3. Do not use the product near water. Never spill liquid of any kind on the product.

4. Do not place the product on an unstable surface. The screen is glass and can be broken.

5. Do not expose the product to a heat source or leave it in direct sunlight for a prolonged 
period of time.

6. Do not allow anything to rest on the power cord. Do not locate the product where 
persons will tread or trip on the cord.

7. Never push objects of any kind into this product except the stylus used for reset.

Power Cord Requirements

The included power cord set(s) (appliance coupler, flexible cord, and wall plug) meets the 
requirements of the FCC and EC.
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Interference

This equipment has been tested and found to comply with FCC and EC regulations as noted 
above. This includes the PDA, the supplied GPS receiver, and the Bluetooth CompactFlash unit. 

Battery Safety

The Lithium Ion battery used in the device is designed to be recharged many times. Use only the 
AC charger that came with your unit. Never use a modified charger. The charging temperature 
should be between 0° C and 50° C (32° F and 120° F). The battery pack will normally warm 
during charging.

Storage: The lithium ion battery should be between 25% and 75% of full charge when stored for 
a long period of time. Store in a cool, dry, well ventilated area. Elevated temperatures can result in 
loss of battery performance, leakage, or rust. Do not expose the battery to open flames. If you 
own more than one battery where one is only used as a backup, it would be a good idea to rotate 
them every few months. Be careful not to short the output terminals.

ABCD12345678
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C
Appendix C - Firmware Updates
The design of your WayPointtm PDA permits easy installation of firmware upgrades. A firmware 
upgrade can be used to re-install a full copy of the Pocket PC OS and all of the included 
applications. The upgrade writes the this data into a 32 Megabyte area that has been provided to 
hold the data and does not disturb the 128 Meg ROM area used to store maps and navigation 
settings.

Warning - A firmware upgrade performs a hard reset. All user data stored in RAM will be 
destroyed. It is highly recommended that the user backup RAM data before applying a ROM 
upgrade.

Backup
There are 4 backup strategies that can be employed to preserve user data.

1. ActiveSync can be used to sync PIM data to your PC. Mac or other computer users may 
have a similar tool to do this job. Data synced to the main computer can be restored after 
the upgrade simply by syncing again. Generally PIM data includes all of your contacts, to-
do lists, and schedules. This list can vary depending on how you set up your sync 
application.

2. ActiveSync (and some third party tools) provides the ability to backup all of RAM. If you 
have additional data beyond PIM data you can use this method to save your information. 
The main problem with this approach is that when the data is restored it could overwrite 
some new ROM information. For example, if you load an application that overwrites 
some system files and these system files are update in the ROM upgrade the restore could 
actually overwrite these updated files with older versions. Third party programs often 
allow selective restores which helps prevent this kind of problem.

3. You can manually copy critical data to your computer or to a memory card. This 
approach requires your understanding of the files you have added but this may be the 
best way. For example, if your added data is stored in My Documents then copying the 
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contents of the directory to a backup place will preserve it. It can easily be restored file by 
file after the upgrade.

Programs that were installed via ActiveSync need not be backed up since ActiveSync 
itself remembers them and can reinstall them. Data created by those programs will need 
to be backed up. Programs installed via cab files can be reinstalled by copying the cab file 
to the unit.

4. You can use the provided Gismo program. This is the approach recommended by 
Mobile Crossing. It provides the flexibility to backup exactly what you need and can 
restore any or all of the backed up data. Backup files can be stored on the Flash Disk (if 
there is room) or on a user supplied memory card. For more information on this 
approach see Chapter 3 “Backup” on page 33.

Performing a ROM Upgrade
Once you have backed up your data you are ready to perform the firmware upgrade. You will 
need a CompactFlash memory card of at least 32 megabytes to perform this upgrade and the 
upgrade file. The upgrade itself may be supplied to you on a CompactFlash card or you may have 
downloaded it from the internet. If you downloaded it from the internet you will need to unzip 
the file before it can be used. The CompactFlash memory card will need to contain the xip.bin 
file at the root of the card to be recognized by the upgrade boot loader. If you have problems 
reading the data you may need to erase the card and ensure that this file is the first one copied to 
the card.

In addition you should ensure that the battery on your WayPointtm unit is charged up so that you 
won’t encounter power problems during the upgrade process. For extra insurance you can insert 
the unit to the charging cradle after the upgrade begins. The CompactFlash card can be inserted 
before the upgrade procedure or when prompted on the screen as part of the procedure. Read 
the following instruction through before beginning and then follow them step by step.

The process starts with a hard reset of the device and then a special key sequence is used to enter 
the e-boot mode. E-boot mode will request the CompactFlash card you have prepared and then 
load it into RAM to verify the file contents. Once this is verified the RAM copy will be used to 
burn the ROM with the new upgrade. A second hard reset will be used to exit the e-boot loader 
and initiate the new ROM. You can now proceed with the standard setup steps you performed 
when you first got the unit. You can restore your backup at any time you wish after these steps.
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1. Remove the battery. and use the stylus to turn off the power and then back on. (Hard 
reset)

2. Depress the voice memo button on the side of the unit.

3. While holding the button down, reinsert the battery and back cover.

4. Continue to hold the button down and look at the screen side - The top banner should 
show “E-boot” after a short period.

5. Let go of the Voice Memo button.

6. The screen will prompt for the CF card. Insert it now if not already done. Wait for the 
upgrade to finish.

7. Repeat step 1.

8. Reinsert the battery and battery cover. After a few seconds the standard WayPointtm 
PDA start screen should appear.

9. Follow the on screen instructions to set up your WayPoint PDA.

After the firmware is installed you can reload backups or software as needed
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Appendix

G
Glossary
ActiveSync - ActiveSync is Microsoft software that runs on a pc. It interfaces between the PDA 
and the host computer. It provide synchronization of PIM data, the ability to backup the data on 
the PDA, internet pass through, and other services. For more information on ActiveSync see the 
Pocket PC reference manual on the CDROM.

API - An API, Application Programming Interface, is a defined interface that provides a method 
for other programs to gain access to either commands or data used by another application.

Autorouting - This term refers to the ability of the unit to take a starting and destination location 
and find a route between these locations that follows the available roads. 

Batch - A Batch file is a file with a .bat extension that contains commands to be executed by the 
CMD shell. It can automate some tasks and can even provide limited programming capabilities. 
Use of this kind of file requires a download of CMD functionality.

Bluetooth - A trademarked name for a short range wireless radio protocol that can be used to 
replace wires in connecting devices together.

CLI - A CLI, command line interface, is a method of starting an application with extra 
arguments passed to the program by appending them to the command name itself.

CompactFlash - CF refers to a technology and physical format used to hold small peripheral 
cards. These cards can contain Input/Output devices or flash memory. The name is trademarked 
by SanDisk.

Fix - A fix in GPS use means that the GPS has acquired data from at least 3 satellites and then 
computed your current location. If it fails to be able to do this it is said to have lost its fix. A fix 
can be either 2D or 3D depending on how many satellites are available and their positions in the 
sky. Four satellites are the minimum needed for a 3D fix.
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Flash - Flash refers to a type of memory used in your WayPointtm unit. Flash memory does not 
lose data when power is removed.

Geocaching - Geocaching is a hobby where some people hide a cache of stuff (none of it 
particularly valuable) and then identify the location with GPS coordinates. Other folks set off to 
find these hidden treasures and leave their name in a log book.

GPS - Global Positioning System. This is a system that provides world wide coverage for your 
GPS receiver. It consists of three parts. The satellites, currently about 28 of them in overhead 
orbits, the GPS receiver you own, and a set of ground stations that constantly monitor the 
system to ensure integrity and to fine tune the satellites.

HDOP - Horizontal Dilution of Position. Dilution of Position is a unitless number that 
represents how good the GPS solution is based on the current satellite positions. For horizontal 
DOP any number less than 2.0 is very good.

Map Loader - The Map Loader program is built in to your WayPoint unit. It can be used to 
purchase additional maps or to manage the ones you have. You can use it to unload or reload 
maps for use in your WayPoint PDA.

NMEA - National Marine Electronics Association. In this context NMEA is a standards body 
that defines the interface specification used by GPS receivers.

PDA - Personal Digital Assistant is a term used to describe a hand held computer. 

PIM - Personal Information Manager is a term used to describe a suite of programs used to 
manage personal information. These include a contact address book, a personal appointment 
calendar, and a to-do list. 

Roadlock - Roadlock is a term that is used to describe an action of the navigation program. With 
roadlock enabled the program will attempt to always keep the GPS icon on the road. If the 
location is too far away from any road then the actual GPS location will be shown. The idea of 
roadlock is to make the program more tolerant of map errors or temporary accuracy errors in the 
GPS system.

Search the sky - This is a term used with the GPS to indicate that it is performing a cold start 
without any local knowledge of its previous position or even the time. Expect that this method 
will take a lot longer to obtain a fix.

Subscreen - In the context of this manual the various applications are said to have a main screen 
containing the major data and various subscreens which are support screens for the main screen. 
In WayPoint navigator the map screen is the main screen and route screens, GPS status screens, 
etc. are subscreens.

USB - Universal Serial Bus refers to an connector on the front or back of your computer or 
peripheral device. It serves as a method for the data or power to get from the computer to the 
peripheral device.
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WAAS - Wide Area Augmentation System. This is a system that is designed to improve the 
accuracy and integrity of the GPS system for air travel. For the US is currently consists of 2 
satellites, one off the east cost and one near the International Date Line. Neither is particularly 
well suited for the west coast but both can be received under favorable circumstances. When the 
signals can be received and the GPS is enabled to use them, accuracy can be improved about 2 to 
3X. WAAS can improve GPS accuracy but it generally not needed for vehicle navigation. In 
Europe there is a fully compatible system is called EGNOS.

WayPointtm - An adjective describing a specific implementation of an easy to use personal digital 
assistant (PDA) designed to provide smart road navigation to drivers and guide them to the 
places they wish to be. WayPoint is a trademark of Mobile Crossing, Inc.

Waypoint - (1) A location in-between your starting point and where you need to be. (2) a marked 
point along a path meant to help guide a traveler to an intended destination.
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WayPoint Software Quick Reference

Press the Button Press and hold the Button

Favorites
Navigate to a favorite location Save current position.

Detour
If no route then bring up route 
form else Route with a Detour

Quick Detour to selected 
Locations (e.g. a gas station)

Status
Check GPS status Repeat last voice prompt 

WayPoint

Switch between previous 
application and WayPoint software 

Display Traffic & Weather if 
available

Shortcuts

Inside a WayPointtm tool , ,  = OK,  = cancel.

Thumb Wheel – Up = zoom out, Down = zoom in, Press to select menu item.

The cursor keypad - scroll, change navigation panes, rotate screens.

Handy Commands

Navigation enable/disable – Tools > Navigation > Active Route Guidance

Route Command – Tools > Navigation > Find Route

Bluetooth - Today > BT icon > Start GPS

Map Loader - check and manage your map collection.

Load maps for WayPoint software - Tools > Choose maps.

Part Code: WPM00
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